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Start ZoomBrowser EX (Windows) or ImageBrowser (Macintosh computers)
and load images onto the computer.

Installing the USB Driver DPOF

The USB driver must be installed to connect the camera to a computer (Windows) via a USB
interface.

To install the USB driver the easy way, ensure that you install the software before you
connect the camera to the computer. This will install the correct USB driver automatically.

« This guide explains the installation method and features of the software for loading and
processing images on a computer that have been shot with a Canon digital camera.
For detailed instructions on how to use the softwares, see the help files of each software.

» Read the agreement in this guide before using the software on the supplied CD-ROM.
By using the software, you agree to be bound by the terms of the agreement.
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READ CAREFULLY BEFORE USING!

CANON SOFTWARE LICENSE AGREEMENT

IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM IN
THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF THIS
AGREEMENT.

This is a license agreement (the “Agreement”) between you and Canon Inc. (“Canon”).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT
USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN THIS BOX
(COLLECTIVELY, THE “SOFTWARE”) AND RETURN THE SOFTWARE WITHIN 30 DAYS FROM
THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and
conditions of this Agreement.

1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a
single computer. You may physically transfer the SOFTWARE from one computer to
another provided that the SOFTWARE is used on only one computer at a time. You
shall not install or use the SOFTWARE on a network, multiple CPU, multiple site
arrangement, or any other hardware configuration where the SOFTWARE is accessible
to more than one CPU or to more than one user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE,
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE,
ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART,
EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up
purposes, or copy the SOFTWARE onto the permanent storage device (e.g. a hard disk)
of your computer and retain the original for back-up purposes. Any other copying of
the SOFTWARE is a violation of this Agreement. You must reproduce and include the
copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or
support for use of the SOFTWARE. No updates, fixes or support will be made available
for the SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose,
maintain and match the hardware and software components of your computer system.
Thus Canon does not guarantee uninterrupted service or correction of errors or that
the functions or performance of the SOFTWARE will meet your requirements. THE
SOFTWARE IS LICENSED ON AN “AS IS”” BASIS AND WITHOUT WARRANTY OF ANY
KIND. The CD-ROM storing the SOFTWARE is warranted only against defective material
under normal use for a period of ninety (90) days after purchase from an authorized
Canon dealer as evidenced by your sales receipt. Your sole remedy for a defective CD-
ROM shall be replacement of the same without charge when returned by you at your
expense to your point of purchase and proven to be defective upon inspection. The
Replacement CD-ROM will be warranted for the remainder of the original ninety (90)
day warranty period of the defective CD-ROM. The limited warranty does not apply if
the failure of the CD-ROM resulted from accident, abuse or misapplication of the
SOFTWARE and shall not extend to anyone other than the original user of the
SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

Disclaimer

« While every effort has been made to ensure that the information contained in this guide is
accurate and complete, no liability can be accepted for any errors or omissions. Canon
reserves the right to change the specifications of the hardware and software described
herein at any time without prior notice.

« No part of this guide may be reproduced, transmitted, transcribed, stored in a retrieval
system, or translated into any language in any form, by any means, without the prior written
permission of Canon.

« Canon makes no warranties for damages resulting from corrupted or lost data due to a
mistaken operation or malfunction of the camera, the software, the CompactFlash™ cards
(CF cards), personal computers, peripheral devices, or use of non-Canon CF cards.

Trademark Acknowledgments

« Canon, EOS and PowerShot are trademarks of Canon Inc.

« ArcSoft, the ArcSoft logo, ArcSoft Photolmpression and ArcSoft Videolmpression are trade-
marks or registered trademarks of ArcSoft, Inc.

« Adobe, Adobe PhotoDeluxe and Photoshop are trademarks of Adobe Systems Incorporated.

» CompactFlash is a trademark of SanDisk Corporation.

« IBM is a registered trademark of International Business Machines Corporation.

 iBook and iMac are trademarks of Apple Computer, Inc.

* Macintosh, PowerBook, Power Macintosh and QuickTime are trademarks of Apple Computer
Inc., registered in the United States and other countries.

« Microsoft, Windows and Windows NT are either registered trademarks or trademarks of
Microsoft Corporation in the United States and/or other countries.

« Other names and products not mentioned above may be registered trademarks or trademarks
of their respective companies.

Copyright © 2001 Canon Inc. All rights reserved.



NEITHER CANON NOR ANY OF CANON'’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION,
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF
PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE
SOFTWARE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON'’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in
effect until expiration of all copyright interests in the SOFTWARE unless earlier
terminated. You may terminate this Agreement by destroying the SOFTWARE. This
Agreement will also terminate without notice to you if you fail to comply with any of
the terms of this Agreement and you must then promptly return the SOFTWARE. In
addition, Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with
restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in
either subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software
clause at DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial
Computer Software Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found
to be illegal by any court or tribunal of competent jurisdiction, such provision shall be
null and void with respect to the jurisdiction of that court or tribunal and all the
remaining provisions of this Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the
Software in the United States of America shall be governed and construed in all
respects in accordance with the laws and regulations of the State of New York, without
reference to choice of law principles. The terms of this Agreement as it relates to
purchases of the Software in Canada shall be governed by the laws of the province of
Ontario.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights,
to the SOFTWARE belong to Canon, its affiliated corporations and third party licensors.
Your use of the SOFTWARE is subject to the United States, Canada and other applicable
copyright and trademark laws and nothing in this Agreement constitutes a waiver of

the rights of Canon, its affiliated corporations and third party licensors under such laws.

Nothing contained in Paragraph 1 shall be construed to give Canon any ownership
rights in any images, graphics or textual material that you save in connection with the
Software.

10. ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS
TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON
CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS OR
PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS
BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO AMENDMENT
TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY AUTHORIZED
OFFICER OF CANON.

Windows

Macintosh



il
Introduction

Thank you for purchasing a Canon digital camera. This guide explains how to use the
software bundled with your camera.

Where to Find Instructions for Attaching Your Camera to a Computer
Models Where to Find the Instructions

PowerShot Pro90 IS
PowerShot G1
PowerShot A10/A20
PowerShot S300 DIGITAL ELPH Camera User Guide
DIGITAL IXUS 300

PowerShot S110 DIGITAL ELPH

DIGITAL IXUS v

EOS D30

PowerShot S10/S20 [Connect.pdf] file contained on the Canon Digital
PowerShot S100 DIGITAL ELPH Camera Solution Disk*

DIGITAL IXUS

* Connection information can be found on the Canon Digital Camera Solution Disk by
opening the [Readme] and [English] folders and selecting the [Connect.pdf] file. Adobe
Acrobat Reader must be installed to read this file. If you do not have a copy installed, please
use the following procedures to install it.

* Windows
Open the [Readme], [English] and [Acrobat] folders and double-click the [ar405eng.exe]
file to start installing.

* Macintosh

Open the [Readme], [English] and [Acrobat] folders and double-click the [Reader
Installer] file to start installing.

Safety Precautions

Please read the safety precautions carefully before using this product. Ensure that you use
the product correctly according to the procedures described in this guide.

The following safety precautions are intended to instruct you in the safe and correct
operation of the product and its accessories to prevent injuries or damage to yourself,
other persons and property. Please read and ensure that you understand them before
you proceed to the other sections of this guide.

A\ Warnings This mark indicates topics that could lead to death or serious injury if
ignored or handled incorrectly.

A\ Warning

« Do not play the supplied CD-ROM(s) in any CD-ROM Player that does not support
data CD-ROMs. The extremely loud sound that may result from playing the CD-
ROM(s) in an audio CD player (music player) could damage the speakers. It is also
possible to suffer hearing losses from listening with headphones to the loud
sounds of a data CD-ROM played on a music CD player.
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Introducing the Software

This section introduces the powerful software programs for the Windows platform
contained on the CD-ROM included with the camera.

Canon Digital Camera Solution Disk

Some camera models do not support some of the software functions. Please
check the Camera and Software Compatibility chart to confirm the compatibility
of your camera. (O p. 5)

ZoomBrowser EX

To load camera images, start ZoomBrowser EX.

Camera Connection Functions
(Also effective for CF card readers or PC card readers)
< Displays camera images.
« Downloads still images and movies from the camera to the computer.
 Loads and saves RAW images in the RAW format.
» Converts and saves RAW images in other formats.
« Saves computer images to a CF card in the camera.
« Edits slide shows for replay on the camera.
« Edits the print order settings (DPOF-compliant settings) of images on a CF card.
« Connecting to a USB port automatically starts ZoomBrowser EX and displays the
camera images.
« Sets the camera parameters.

Image File Management Functions

« Displays, moves, copies or deletes images stored on computer disks.

= Allows simple editing procedures, such as image color adjustments and cropping.

« Displays all the files in a specified folder at once and zooms them in and out to
facilitate visual searches.

< Displays files in chronological order in a window that looks like a time tunnel.

» Replays images from the computer one-by-one at full screen size to simulate a
slide show.

Image Printing Functions

< Prints multiple images on the same page using the PhotoRecord printing utility.

 Performs auto layouts.

= Allows you to effortlessly place frames or backgrounds around your images for
artistic effect.

 Allows you to place titles or captions anywhere on the page.

« Lets you create your own exclusive photo albums.

« Creates layouts conforming to Canon Perforated Paper dimensions.
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Supports PhotoStitch Panoramas

« Allows you to select camera images or images registered with ZoomBrowser EX and
start PhotoStitch from within ZoomBrowser EX to merge a series of images into a
panorama in a few simple steps.

Supports ArcSoft Photolmpression, Adobe Photoshop LE or
PhotoDeluxe Home Edition
< Allows you to select images registered with ZoomBrowser EX and start one of these

photo-retouching programs from within ZoomBrowser EX to edit and apply special
effects to your images.

Starts Your E-mail Program

~ Starts your e-mail program and prepares images as e-mail attachments.
 Allows you to adjust image size and compression settings so that large files can be
made smaller for transmission.

PhotoStitch

« Effortlessly merges images that are shot over several frames with a camera.

< Automatically arranges images shot in Stitch Assist mode into the correct order and
effortlessly merges them.

« Merges any number of images horizontally or vertically, or in a matrix format.

» Makes images with straight lines appear natural not crooked when merged. (Select
the wide display format.)

» A 360-degree scene shot in several frames can be merged into a 360-degree image
and saved in the QuickTime VR format, making it appear as if you were standing in
the middle of the image looking about in all directions.

Windows

RemoteCapture
« Connecting via a USB port allows you to release the camera’s shutter button from
the computer. The images load directly into the computer.
» Connecting via a USB port also allows you to load images directly into the computer
by clicking the camera’s shutter button.
 Allows interval shooting with custom interval and frame settings.

TWAIN Drivers

Canon Digital Camera USB TWAIN Driver (For Windows 98/Me/2000)
Canon Digital Camera RS-232C TWAIN Driver

These are the driver utility programs that work within TWAIN-compliant
application programs, such as Adobe Photoshop, to load camera images directly
into the application program. The USB TWAIN Driver is for connecting via a USB
port. The RS-232C TWAIN Driver is for connecting via a serial (COM) port. Install
the RS-232C TWAIN Driver if you are going to load images via a CF card reader or
PC card reader in Windows 95 / Windows NT 4.0. Start either TWAIN driver from
a TWAIN-compliant application program. Neither TWAIN driver can be used as a
stand-alone program.
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USB WIA Driver
Canon Digital Camera USB WIA Driver (For Windows Me)

As the driver software for the USB interface, it can automatically start
Windows’ Scanners and Cameras Wizard and download images to the
computer. It can also display the images in the camera as thumbnails in
Windows Explorer, allowing them to be effortlessly downloaded just by
copying them to a folder.

Apple QuickTime

« Installing Apple QuickTime allows you to replay the movies you shot or view images
in the QuickTime VR format that you merged with PhotoStitch.

ArcSoft Camera Suite CD-ROM*

ArcSoft Photolmpression
 Allows you to edit and apply special effects to images as well as effortlessly create
greeting cards and calendars.
ArcSoft Videolmpression

« Allows you to effortlessly edit and save movies, making it easy to integrate movie
clips and stills into a single movie or delete frames.

9,
( Adobe Photoshop LE CD-ROM*
Adobe Photoshop LE

« Allows you to edit images, apply special effects, print and create sophisticated
graphics for the web.

'
A Adobe PhotoDeluxe Home Edition CD-ROM*

Adobe PhotoDeluxe Home Edition

« Allows you to edit images and effortlessly create greeting cards, birthday cards and
calendars.

* The retouching software bundled with cameras varies between camera
models. Some models are not bundled with retouching software. Please
refer to the System Map for the programs supplied with your camera.
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Camera and Software Compatibility

The Canon Digital Camera Solution Disk contains a number of software programs and
drivers. Check the chart below for the compatibility of your particular camera model with
each program’s special functions.

Model
PowerShot Series

I I I

o o [sW o

o | o | o & >

=l2|2|2|2|2

a | o o T T < = = = =S =G (=« v
a3 3 — S S S S = o o o ;

Function Software 2l s| |3 |2 |3 | S |3|a|a|a 3
Computer USB(l) ° ° ° ° ° ° ° ° ° ° ° -8
Interface  ggrial - . . . - - - - - - - g
Downloading ZoomBrowser EX | . . . . . . . . . .
Camera Images | TWAIN Driver
Dow_n loading ZoomBrowser EX - D D - - - o o - o o
Movies
RAW Image ZoomBrowser EX R R R _ _ B B B B B B
Conversion TWAIN Driver
Uploading ZoomBrowserEX | e . . ° . ° ° ° ° ° °
Images to Camera
Editing Camera
Slide Show ZoomBrowserEX | - . . . - - - - - - -
Editing Camera
Print Settings ZoomBrowser EX D o o o . D o o B B B
Merging Images
Shot in Stitch PhotoStitch - B oG] o . . . . . . .
Assist Mode
Shooting from o
the Computer RemoteCapture@) | o . . - . - . o - o o

(1) Only compatible with computers with built-in USB ports running pre-installed versions of
Windows 98, Windows Me or Windows 2000.

(2 Only compatible with the USB interface.

() Images shot with the Wide Converter, Tele-converter or Close-up lens do not merge well in
PhotoStitch.
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System Requirements

The following system requirements must be met to install and operate the software.

1

—@ Computer Model

IBM PC / AT compatible

—0S

Windows 95, Windows 98 (Including the Second Edition),
Windows Millennium Edition (Windows Me), Windows NT 4.0
(Service Pack 3 or a later version required) or Windows 2000.

——e@CPU

Pentium 150 MHz or better

RAM
32 MB or more (Windows 95/Windows 98)
64 MB or more (Windows Me/Windows NT 4.0/Windows 2000)

-—@ Interface

USB: (Limited to pre-installed Windows 98, Windows Me or
Windows 2000 systems)
RS-232C: (Serial or COM Port)

-—@ Free Hard Disk Space

Canon Utilities

ZoomBrowser EX: 120 MB or more
(Including the PhotoRecord printing utility)

PhotosStitch: 40 MB or more

RemoteCapture: 20 MB or more

Canon Digital Camera USB TWAIN Driver: 25 MB or more
Canon Digital Camera RS-232C TWAIN Driver: 15 MB or more

Canon Digital Camera USB WIA Driver: 25 MB or more
Adobe Photoshop LE*: 40 MB or more
Adobe PhotoDeluxe Home Edition™: 140 MB or more
(Works with the Windows 95/98/NT operating systems)
ArcSoft Photolmpression™; 125 MB or more
ArcSoft Videolmpression™: 30 MB or more
@ Display
Minimum: 800 x 600 pixels, 256 colors (8 bit)

Recommended: 1,024 x 768 pixels, High Color (16 bit) or more
High Color (16 bit) or more is required to use ArcSoft
Photolmpression or ArcSoft Videolmpression.

* The retouching software bundled with cameras varies between camera models. Some models
are not bundled with retouching software. Please refer to the System Map for the programs

supplied with your camera.

« A cable connection via a USB port is only supported for computers pre-installed with Windows
98, Windows Me or Windows 2000, or those upgraded to Windows Me from a pre-installed

version of Windows 98.

« A CD-ROM drive is required to install the software.

< QuickTime 3.0 or a later version is required to replay movies captured by the camera or to save
images merged with PhotoStitch in the QuickTime VR format.

* QuickTime 4.1 is contained on the Canon Digital Camera Solution Disk.

< Asound card is required to replay soundtracks for movie files.
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Installing/Uninstalling the Software

Installing from the Canon Digital Camera Solution Disk

If you are installing the software onto Windows NT 4.0 or Windows 2000, you must first
log on as the administrator and then install the software.

Precaution about the USB Interface

« Ensure that you install the software from the Canon Digital Camera Solution Disk
onto the computer before you attach the camera to the computer’s USB port. If
you attach the camera to the USB port after installing the software, it will
automatically select the correct USB driver.

1. Close any programs that are running.

Windows

2. Place the Canon Digital Camera Solution Disk in the CD-ROM drive.
The installer panel will automatically display.

Canon

B © Software Installation

Canon Utilities
ZoomBrowser EX

- PhatoRecord
PhataStitch

- RemoteCapture

Digital Camera USE TWAIN Driver
Digital Camera R5-232C TWAIN Driver

A ¥ © QuickTime Installation

® To Users of WA Driver
: [windows Me only)
| @ List of Supported Camera Models

® ZoomBrowser EX Software Guide

@ Canon Digital Camera Web Site

> Exit

« If the installer panel does not automatically display, use the following procedures
to start it.

1. Double-click the [My Computer] icon on the desktop, and double-click the
CD-ROM icon in the next window.

2. Double-click the [Setup] icon.
3. Click [Software Installation].
4. Select the install location and click the [Next] button.

5. Select the software you wish to install and follow the on-screen
instructions to proceed.

6. Click the [Exit] button when the installation is complete and the installer
panel appears again.
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Installing from the ArcSoft Camera Suite CD-ROM

To install ArcSoft Photolmpression or Videolmpression, place the ArcSoft Camera Suite
CD-ROM into the drive and double-click the [My Computer] icon on the desktop
followed by the [ArcSoft] folder and [Setup.exe] icon. Follow the on-screen instructions to
install the program.

Installing from the Adobe Photoshop LE CD-ROM

To install Adobe Photoshop LE, place the Adobe Photoshop LE CD-ROM in the drive and
double-click the [My Computer], [Photosle], [English], and [Photosle] folders, followed by
the [Setup.exe] file. Follow the on-screen instructions to continue with the installation.

You must input the software serial number to install Adobe Photoshop LE.
It can be found on the CD-ROM case.

Installing from the Adobe PhotoDeluxe CD-ROM

For installation instructions, place the Adobe PhotoDeluxe CD-ROM in the drive and click
[Readme & Guide] and [Install Guide] in the window that displays.

Write down the serial number shown during installation because it is required
for the user registration process.

Uninstalling the Software

« To remove the installed software, click the Windows [Start] menu and select [Settings],
[Control Panel] and [Add / Remove Programs]. ZoomBrowser EX can also be uninstalled
by clicking the [Start] menu and selecting [Programs], [Canon Utilities], [ZoomBrowser
EX], and [ZoomBrowser EX Uninstall]. (PhotoRecord, PhotoStitch and RemoteCapture
can be removed with the same procedures.)

« To remove ArcSoft Photolmpression or ArcSoft Videolmpression, click the Windows
[Start] menu and select [Programs], [ArcSoft Camera Suite], and [Uninstall].

« To remove Adobe Photoshop LE, click the Windows [Start] menu and select [Programs],
[Adobe], [Photoshop Limited Edition] and [Uninstall Photoshop Limited Edition].

» To remove Adobe PhotoDeluxe Home Edition, click the Windows [Start] menu and
select [Programs], [Adobe], [PhotoDeluxe Home Edition] and [Uninstall PhotoDeluxe
Home Edition].
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Installing the USB Driver
(Preinstalled Windows 98/Me/2000 Systems Only)

Notes Regarding Installation

« Ensure that you install the contents of the Canon Digital Camera Solution Disk
before you attach the camera to the computer’s USB port. This will allow the
automatic selection of the correct USB driver.

= The USB driver only needs to be installed the first time the camera is connected via the
USB interface. Installation is not required from the second time onward.

« Do not cancel the installation partway through. Allow the procedure to finish completely
before exiting. The camera may not operate correctly if the installation is incomplete.

 Read the ““Troubleshooting the USB Driver Installation” section on page 52 if the
installation cancels itself during the procedure, if the installation does not proceed as
described in these procedures, or if you think that the drivers are not properly installed.

 Read the “Uninstalling the USB Driver” section on page 52 for instructions for that
procedure.

Installing the USB Driver

Windows 2000 users should log on as the Administrator before commencing installation.

1. Once you have attached the USB cable to the camera and computer, set
the camera to the mode for communicating with a computer.

Refer to Where to Find Instructions for Attaching Your Camera to a
Computer (O p. ii) for connection instructions.

The “Add New Hardware Wizard™ dialog will appear after a moment and
automatically install the USB driver.
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Windows Me or Windows 2000 Users

If the “Digital Signature Not Found” message displays partway through installation,
follow the procedures below.

1. Click the [Yes] button if the “Digital Signature Not Found”” message
displays.

Digital Signature Not Found =

The Micrasaft digital signature affims that saftware has
been tested with Windows and that the software has ot
been altered since it was tested

The software you are about (o install does not contain a
Microsoft digital signature. Thersfore, there is no
quarantee that this software works correcty vith
Windows

Your camera model name
will appear here.

IF you wank to search for Micrasoft digitally sianed
software, wisit the Windaws Updats Web sits at
hitp: Hindowsupdate microsoft com to see if ane is
avallable

Do you want to continue the installation?

T ——
( s n Ne | Moreinfa
z

2. Click [No to All] if the “Confirm File Replace” dialog displays.
E

Source: e\USE_DRY\bwain dil
Target: CAWIND OS5 \biain. dil

The target file exists and is newer than the source

Qverwite the newer file?

Yes | Mo Notoal |

N

« If a dialog prompts you to restart your computer, remove the CD-ROM from the
drive and restart the computer as instructed.

Installing and uninstalling the WIA driver
If you are using Windows Me, you can choose to install the WIA driver instead of the
default USB Twain driver.
1.Set the Solution disk in the CD-ROM drive.
The install panel opens automatically.
2.Click [To Users of WIA Driver].

The restrictions for WIA driver operation notice and install/uninstall methods are
displayed. If you intend to use the WIA driver, please look at these restrictions for
WIA driver operation. Read the information carefully and then start the installation.

When you uninstall the driver, also read and follow the information.
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Using ZoomBrowser EX the First Time
(From Loading to Printing)

This section provides a simple explanation of the procedures for using ZoomBrowser EX
to perform each of the steps from loading to printing. Please refer to the ZoomBrowser
EX Help file or PDF file (ZoomBrowser EX Software Guide) for more details. You can
access the ZoomBrowser EX Software Guide from the installer panel.

Some camera models do not support all of the connection interfaces. Please
check the Camera and Software Compatibility chart to confirm your camera’s
compatibility. (O p. 5)

What to Do if the “Caution! Connection Time” Dialog Displays

« If a set period of time passes without a camera function being accessed when the
camera is connected via the USB interface, a message on the computer display will
ask if you wish to remain connected. If you do not access a function, the camera will
close the connection after an additional minute passes. (The power will remain on
and no message will appear if the camera is powered by a household power source
or its auto power off function is set to Off (excluding PowerShot S10/S20 models)).

« To reopen the connection, press the camera’s shutter button or main switch. Please
see the Camera User Guide for details.

Starting ZoomBrowser EX
USB Interface

1. Attach the camera to the computer with the USB cable.

Refer to Where to Find Instructions for Attaching Your Camera to a
Computer (O p. ii) for connection instructions.

2. Set the camera to the mode for communicating with a computer.

After a moment, an event dialog will allow you to select an application program
to start.

3. Select [Canon ZoomBrowser EX] and click the [OK] button.

Your camera model name
will appear here. _%

Please choose which application shou@d
teceive the image.

Registered Applications
wser EX

ZoomBrowser EX will start and display the camera’s images as small thumbnail
images in the ZoomBrowser EX Camera Window. (O p. 14)

Quick Tips will automatically display. Read these tips to quickly again an
understand of the operating procedures.

Windows
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How to Have ZoomBrowser EX Start Automatically

« If you want ZoomBrowser EX to start automatically without first displaying the
event dialog, use the procedures below to change the settings.

1.
2.

3.
. Alist of applications registered for automatic starting will display. Remove the

Open the [My Computer] window while the camera is connected to the
computer via the USB interface.

Open the [Control Panel] and select [Scanners and Cameras] and your camera
model.

Click the [Properties] button and display the [Events] tab.

checks beside every program except for ZoomBrowser EX. Click the [OK] button.
ZoomBrowser EX will start automatically the next time you connect the camera. If the
[Disable device events] option has a check mark, the automatic start will be turned off.

CF Card Reader or PC Card Slot Interface

1.

Place the CF card into the CF card reader or into the PC card adapter
and then into the PC card slot.

Refer to Where to Find Instructions for Attaching Your Camera to a
Computer (O p. ii) for connection instructions.

Start ZoomBrowser EX.
Double-click the [Canon ZoomBrowser EX] icon on the desktop to start the program.

Canon ZoomBrowser EX Icon

If the [Canon ZoomBrowser EX] icon does not appear on
the desktop, click the Windows [Start] button and select
[Programs], [Canon Utilities], [ZoomBrowser EX] and
[ZoomBrowser EX].

Quick Tips will automatically display. Read these tips to quickly understand
operating procedures.

Click the [Import Images] button and select [From D:\Dcim].

The images from the CF card will display in ZoomBrowser EX Camera Window as
small thumbnail images. (O p. 14)

“Image Library One" folder
_ C_Dmain_s 2 e_s_ub-folders _I Total images: 50
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Serial Interface

1. Attach the camera to the computer with the serial cable.

Refer to Where to Find Instructions for Attaching Your Camera to a
Computer (O p. ii) for connection instructions.

2. Set the camera to the mode for communicating with a computer.

3. Start ZoomBrowser EX.
Double-click the [Canon ZoomBrowser EX] icon on the desktop to start the program.

Canon ZoomBrowser EX Icon

If the [Canon ZoomBrowser EX] icon does not appear on
the desktop, click the Windows [Start] button and select
[Programs], [Canon Utilities], [ZoomBrowser EX] and
[ZoomBrowser EX].

Windows

Quick Tips will automatically display. Read these tips to quickly understand
operating procedures.

4. Click the [Import Images] button and select [From Canon Camera].
The camera’s images will display as small thumbnail images in the ZoomBrowser
EX Camera Window. (O p. 14)

[ NoM[ 2
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The ZoomBrowser EX Camera Window

The Camera Window will open when a connection to a camera or CF card is initiated.
Thumbnail (small) images will display.

An image of the connected Thumbnail
camera or CF card will display.

% Photos on Ci|mera Folder - E:A\Dcim

Finished collscting im |aes for display.

Total Dimages
[ [ [

Setup Options Button Delete Button Upload Button

Sets various camera Deletes the Copies images from the computer
settings (see inset below) selected to the camera or CF card. (O p. 24)
using the computer. images. Download Button

Copies selected images to the computer
from the camera or CF card. (O p. 15)

How to Check and Change Various Camera Settings

< You can adjust the date, time and owner settings in the Camera Settings dialog
using the computer when the camera is connected. You can also check the battery
charge and remaining memory capacity.

1. In ZoomBrowser EX, click the [Setup Options] button to open the Camera
Settings dialog. Or in TWAIN Driver, click the [Camera Settings] button to open
the Camera Settings dialog.

2. Check or change the settings.

Input a camera owner name here. (up
Camera Settings /_
e to 31 characters)

Camera Modet  :GO00000G0000

Fimmware Versiore 300006 | sSet the date and time.
et N = Click this button to synchronize the
[RR0aTT00EE0H /_ camera to the computer’s date and
Date and Time: 1 1
R % 2000 j R TR P j From PC time SettlngS.

|_—— Check the battery charge here.

Formats the CF card in the camera.
(Except in PowerShot S10/S20 models)

Battery Status: é AC Charger /
CF Card: Format /

‘ Status: nstalled 1% i | - .
ata — Check the remaining memory capacity
Berameters. .\ here.
I —
] corl_| e Sets the camera parameters. (O p. 48)

(Supported by the EOS D30 only)
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Loading and Saving Images from the Camera

1. Create a new folder in which to save the images from the camera.

In the Tree View, right-click the [Image Library One] folder, select [New Folder] from
the pop-up menu and input a folder name.

< My Database.zbd - ZoomBrowser EX

Fie Edit View Attibutes Help

Image Library Cne

Tree V|eW Set Logical Yelume Marme
St Folder Color...
F e Folde bl

2. Select the new folder in the Tree View.

File Edit Miew Attibutes Help

2
o
S
=
=

Canon Camera
=l Imags Library One
] MyImages

3. Select the images that you wish to download from the Camera Window
and click the [Download] button.
Click the thumbnail you wish to select or press [Ctrl] and click to select multiple
thumbnails.

“RAW” will display on RAW images.

Thumbnail The movie icon will display
on movie thumbnails.

Finished collecting images for display

Totak 6 mages

The downloaded images will be saved to the computer disk and appear in the
Browser Display Area.
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 You can also download images to the computer by dragging them from the
Camera Window and dropping them on the Browser Display Area or Tree View.

Browser Display Area

+ My Database.zbd - ZoomBrowser EX
Fle Edt View Aftibutes Help

(T Canon Camera
1 Image Library One
L1 My Images
L1 Samples
Tiavel

Tree View

For Help. press Fl

518 AUTIPG AW e

—“RAW” will

display on
RAW images.

L The movie
icon will
display on
movie
thumbnails.

I T

To disconnect the camera, click the close box x| at the upper right of the Camera

Window. The Camera Window will close.
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Printing Images

1.

Select the image(s) you wish to print and click the [Print Layout] button.

< Movie images cannot be printed.
< You must convert RAW images before printing them (O pp. 40-41, 52-54).

856-5661_AUT.JPG (=,
Friday, September 10, 1999, 3:37 PM
£

B ER D (g

For Help, press F1 —’m,_ ~
|— Print Layout Button

The PhotoRecord printing utility will start and automatically display the selected
image(s) in a page layout.

Windows

Adjust the print settings if you wish to change the page layout.
Please refer to page 30 or the PhotoRecord Help file for details of the settings.

Click the PhotoRecord [Print] button.

% Swiss Alps.alb - PhotoRecord
File Edit Album View Web Help

x|

Swiss Alps

Swiss Alps

Print Button

PRINT

=—TNUM 2

The Print dialog will display.

4. Click the [OK] button to start printing.
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Using Additional ZoomBrowser EX Functions

This section explains the additional features of ZoomBrowser EX. Please refer to the
ZoomBrowser EX Help file or PDF file (ZoomBrowser EX Software Guide) for more details.

Some of the software functions are not supported by all of the camera models.
Please check the Camera and Software Compatibility chart to confirm your
camera’s compatibility. (O p. 5)

Displaying Images
Zooming Images In and Out

(a) Double-Clicking the Browser Display Area

Double-click the background frame of the folder in which an image is registered
to zoom it to fill the Browser Display Area.

4 )

— Double-click the
background frame
of the folder.

Browser Display Area

N _J

Click this button to go back to
a folder one level higher.

(b) Selecting a Folder in the Tree View
You can also zoom a folder in or out with its icon selected in the Tree View.

i i [ Canon Camera
Click a higher level folder to zoom out. mage Library One

) 3 _ | My Images
Click a lower level folder to zoom in. = 0 Famples
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Zooming a Single Image

Double-click an image in the Browser Display Area to display it in the Image Viewer.

Transport

arurm, a4 pa
=

Double-click the target image.

I— Edit Panel Button

About the Image Viewer Edit Panel
 The edit panel displays when you click Edit Panel button in the Image Viewer.

Crop Button

Drag the cursor to
select the crop area
and click the [CROP]
button to trim

everything outside the Color / Brightness / Contrast Sliders
crop area. Slide the tab to adjust the color,

Save As Button brightness or contrast settings.

Save the image with — Undo / Redo Buttons

a different name and Reverse an action or reimplement it.

file format.
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Replaying Movies

Double-click a thumbnail with the movie icon to start QuickTime Player and replay
the movie.

883-8314_MVLAVI X

| agsmman £ ]

9_\@3,_&/.

« If QuickTime 3.0 or a later version is not already installed, install it from the Canon
Digital Camera Solution Disk.

Displaying Images in Chronological Order

Select a folder or some images, click the [View] menu and select [TimeTunnel]. The
selected image(s) will display in a time tunnel. Please refer to the TimeTunnel Help file
for more details on how to operate this function.

{3 Ti

105/06/00 12:00-__

A
1 o
B e Pt |
.

Drag the tab up or down to go
backward or forward in time. The
time tunnel will advance in the
selected direction.

To quit TimeTunnel and return to
the ZoomBrowser EX window,
click this button.
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Showing Images in a Slide Show

The slide show function displays images saved onto the computer disk one-by-one at
full-screen size as if they were part of a slide show.

1. Click the [View] menu and select [Slide Show Options].

2. Select a play method.
The “Slide Show Options™ dialog will display.
Set a play interval and a transition effect and click the [OK] button.

3. Select images from the ZoomBrowser EX Browser Display Area for
showing.

4. Click the [View] menu and select [Slide Show].
The selected images will play in order. The slide show will close after the last
image is displayed. If the slide show is set to repeat, press the [ (close) button
on the control panel to close the slide show.

Windows

About the Print Mark Button

« If the [Print Mark] button is clicked while an image is played in a slide show,
PhotoRecord will automatically start after the slide show has finished and place the
displayed image with a print mark in an auto layout.

« Please refer to page 30 or the PhotoRecord Help file for more details on how to
operate this function.

Print Mark Button
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Organizing Images
Changing the File Location

You can move an image file by dragging and dropping it onto another folder icon.

Drag an image from the Browser Display Area
to another folder in the Tree View.

= My Database.zbd - ZoomBrowser EX
File Edt View Attibutes Help

EIE Image Library ©ne —— Browser Display Area

1 Semples
1 Travel

— You can also drag
and drop images
within the Browser
Display Area.

For Help, press F1 oM
L Tree View

The [Image Library One] folder is located within the folder in which ZoomBrowser EX
was installed. The Tree View displays files at levels below this folder.

Adding a New Library Folder

Adding a folder to the Tree View allows you to display the images in that folder and its
subfolders in ZoomBrowser EX. Click the [File] menu, select [Add Image Library] and
select the folder. The selected folder will appear in the ZoomBrowser EX Tree View as a
new library.

Refreshing the Contents of a Library

If you have used another program, such as the Windows Explorer utility or Adobe
Photoshop LE, to move or edit images registered with ZoomBrowser EX, you should
select the library, click the [View] menu and select [Refresh Current Library]. This will
update the library.
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Erasing Images

An image cannot be recovered after it is erased. Double-check to make sure you have
the right images before erasing.

Erasing Images Singly

1. Select the target image in the Browser Display Area and click the
[Delete] button.
A confirmation dialog will display.

2. Check the image to make sure it can be deleted and click [Delete].
The image will be erased.

Windows

Erasing Images by Folder

1. Click the background frame of the target folder and the [Delete]
button.
A confirmation dialog will display.

2. Check the images to make sure they can be deleted and click [Delete].
The images and the folder will be erased.

+ My Database.zbd - ZoomBrowser EX _ O] x|
Eile Edit “iew atibutes Help

Canon Camera e
&l Image Library One Tiavel = — Browser

e _ RA Display Area
— Click on the
5! folder’s
E——— oD background
frame to erase
the folder and
all its images.

— Click images

singly to
erase them.

[ WM

For Help, pr{:ss F1

L

L

Tree View Delete Button
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Saving Computer Images to a CF Card in the Camera

1.
2.

Open the Camera Window. (O pp. 11-14)

Click the [Upload] button in the Camera Window.
The “Upload Images from Disk™ dialog will display.

Select the images from the computer and click the [Open] button.
The “Save to Camera” dialog will display.

Select the image size and resizing options and click the [Save to Camera]
button.
The selected image will be saved onto the camera’s CF card.

Editing Camera Slide Shows

This function allows you to edit slide shows played by the camera. To edit slide shows
shown on the computer display, see “Showing Images in a Slide Show.” (O p. 21)

1.
2.

Open the Camera Window. (O pp. 11-14)

Click the [Slide/DPOF] button.
The Edit Slide/DPOF window will display.

Click [Slide Show] in the upper left area of the window.

The camera images will display on the left side. Images registered in the selected
slide show will display on the right side.

Slide Shows 1 to 3 correspond to the numbers of the slide shows that can be shown
with the camera.

Drag and drop images from the area on the left to the area on the right
to register them in the slide show.

You can drag images to change their order in the area on the right. This order
corresponds to the replay order.

Click the [Save to Camera] button.
The slide show will be saved to the CF card in the camera.

Click the [Exit] button.
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Editing the Print Order Settings (DPOF)

You can specify which images on a CF card you wish to print as well as the number of
copies. You can also select the print type and whether or not the shooting date and file
number information is printed with the image. A convenient feature of these settings is
that they comply with the DPOF (Digital Print Order Format) standards, which allow you
to print on any DPOF-compliant digital printer or order prints from a participating photo
developing laboratory.

1. Open the Camera Window. (O pp. 11-14)

2. Click the [Slide/DPOF] button.
The Edit Slide/DPOF window will display.

3. Click [Print Order (DPOF)] in the upper left area of the window.

4. Select the print type from among the [Standard Print], [Index Print] or
[Both] options.
« Standard .. Set the number of copies of the images you wish to print in the
column below the thumbnails.
e Index ....... A check mark will appear below the thumbnails selected for printing.

Windows

5. Click the [Save to Camera] button.
The print order settings will be saved to the CF card in the camera.

6. Click the [Exit] button.

DPOF Settings Precaution

« A warning message will display if ZoomBrowser EX encounters print settings data
it does not support on a CF card with print settings created by a non-Canon brand
DPOF-compliant digital camera. If any print settings on such a card are changed, all
of them will be overwritten by ZoomBrowser EX and lost.

= Some printers or photo developing laboratories may not be able to reflect all of the
print settings in the output.
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Sending Images via E-mail

You can send images as attachments to e-mail messages. You can adjust the image size
and compression to reduce the file size for transmission.

1.
2.
3.

Select the target image(s) in the Browser Display Area.
Click the [File] menu and select [Send Image(s) by E-Mail].

Adjust the image size and compression.

The e-mail image creation window will display. Set the image size and quality and
follow the on-screen messages to complete the procedures.

Click the [Finish] button.

When you click the [Finish] button, your e-mail program will start and open a new
message with the image file attached. Input your message, a subject, the recipient’s
address and send the message.

Some e-mail programs or operating systems may not support the auto start
function. In that case, temporarily save the adjusted image file to the desktop or
another easy-to-find folder. Then start your e-mail program, open a new message
and attach the adjusted image file to it.
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Merging Panoramic Images with PhotoStitch
To Merge Images Registered in ZoomBrowser EX

< You can merge a series of overlapping images into a single, seamless panorama.

« Select the images in the browser area, click the [Edit] menu and select [PhotoStitch].
The PhotoStitch program will start.

< Follow the instructions in the guidance window to merge the images.

« Please refer to the PhotoStitch Help file for more details.

£ PhotoStitch M [=1 3
Fle Edl Yen bews Hep
m j Merge Images Shot in Stitch Assist Mode
i;‘f [ Clk [2. erge] o merge these:images. . .
» For e ol 60 s, ok Arange, Follow the instructions n
E l select (360 Degress] and then click [2 Merge]. .
to merge the Images. ;
o
| | e
| oz [P ) () -

H_01.jpg H_02jpg H_03.jpg H_04.jpg H_06.jpg

o, of Images: 5 [ (5124384 True Color 4

Images Shot in Stitch Assist Mode

 PhotosStitch automatically arranges images shot with the Stitch Assist mode of
Canon digital cameras in the correct order and orientation, making it easy to
merge these images. Stitch Assist mode images display in the Camera Window as

shown below.
Stitch Assist mode images have a green
stitch mark. Click the stitch mark to start
PhotoStitch and merge them.

+ Photos on Camera

Please see the Camera User Guide for instructions for shooting in Stitch Assist mode.
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Editing and Applying Special Effects to Images
Adobe Photoshop LE

1. Confirm that Adobe Photoshop LE has been installed.
2. Select an image from the Browser Display Area of ZoomBrowser EX.

3. Click the [Edit] menu and select [Edit Image using Adobe Photoshop].

Please refer to the Adobe Photoshop LE Help file and electronic guide (User
Guide.pdf) for instructions for this program.

4. Edit and apply special effects to the image.
e ZoomBrowser EX supports the BMP, FlashPix, JPEG and TIFF file formats.
« If you selected a folder registered in ZoomBrowser EX as the save location,
please return to the ZoomBrowser EX window, click the [View] menu and
select [Refresh Current Library] to update the thumbnail in ZoomBrowser EX.

Adobe PhotoDeluxe Home Edition
1. Confirm that Adobe PhotoDeluxe Home Edition has been installed.
2. Select an image from the Browser Display Area of ZoomBrowser EX.

3. Click the [Edit] menu and select [Edit Image using Adobe
PhotoshopDeluxe Home Edition].
Please refer to the Adobe PhotoDeluxe Home Edition Help file and electronic
guide (Getting Started.pdf) for instructions for this program.

4. Edit and apply special effects to the image.
= Once you have finished editing the image, click the [File] menu, select [Export]
and [File Format], and save the image.
e ZoomBrowser EX supports the BMP, FlashPix, JPEG and TIFF file formats.
« If you selected a folder registered in ZoomBrowser EX as the save location,
please return to the ZoomBrowser EX window, click the [View] menu and
select [Refresh Current Library] to update the thumbnail in ZoomBrowser EX.
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ArcSoft Photolmpression
1. Confirm that ArcSoft Photolmpression has been installed.
2. Select an image from the Browser Display Area of ZoomBrowser EX.

3. Click the [Edit] menu and select [Edit Image using ArcSoft
Photolmpression].

Please refer to the ArcSoft Photolmpression Help file for instructions for this
program.

4. Edit or apply special effects to the image.
ZoomBrowser EX supports the BMP, FlashPix, JPEG and TIFF file formats.
If you selected a folder registered in ZoomBrowser EX as the save location, please
return to the ZoomBrowser EX window, click the [View] menu and select [Refresh
Current Library] to update the thumbnail in ZoomBrowser EX.

Windows

Editing Movies
ArcSoft Videolmpression
1. Confirm that ArcSoft Videolmpression has been installed.

2. Click the [Start] menu and select [Programs], [ArcSoft Camera Suite]
and [Videolmpression].
ArcSoft Videolmpression will start.

3. Click the [New] button, add a movie or still image to the storyboard
(the film strip at the bottom of the window) and perform the edit.
Please refer to the ArcSoft Videolmpression Help file for instructions for this
program.

ZoomBrowser EX supports the MOV and AVI file formats.
Movie files appear as icons in the ZoomBrowser EX thumbnail view.
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Printing Images

« Select a folder or image(s) for printing from the Browser Display Area or Camera
Window and click the [Print Layout] button to start the PhotoRecord program.

= You can also click the i@ button while an image is displayed in a slide show to add a
print mark to it. When the slide show closes, PhotoRecord will start automatically.

« The selected images will automatically display in a page layout.

« Please refer to the PhotoRecord Help file for more details.

PhotoRecord Window

7" Swiss Alps.alb - PhotoRecord
File Edit Album “iew 'web Help

Swiss Alps

Input titles or captions

Click these buttons
to select a layout
pattern for each

page.

anywhere you wish.

Drag the images to
change the layout.

Click the arrow v
to display a pop-up
menu.

Slide this tab to the left
to shrink the image,
right to expand it.

LAYOUT

Click this to switch
between auto and
manual layout mode.

ALBUN

— Click this to stop
importing images.

b4 Switch between control

Click this to set the
album type, paper size
and orientation.

Click this to import images. ——

Click this to change the background design.

_L panel sizes with this.
= L Click this to display

Help.

—— Click this to display the
Print dialog.

L Click these buttons to
undo or restore the
previous action.
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The PhotoRecord layouts with titles and captions can be saved as albums. Moreover,
PhotoRecord includes a variety of templates, making it easy to create beautiful albums.

1. Tosave an album, click the PhotoRecord [File] menu and select [Save As].

2. Input a name and click [Save].

Add a title to the page
Click the arrow ¥ and select
[Edit Title] from the pop-up
menu.

Add a caption to an image
Right-click an image and select [Edit
Caption] from the pop-up menu.

Change the photo frame

Right-click the image and
select [Change Photo Frame]
from the pop-up menu.

Change the page background
Right-click the page and select
[Change Page Style] from the
pop-up menu.

-

Swiss Alps —

Windows

Insert text

| Page 1

Click the arrow ¥ and select [Add Text]
from the pop-up menu.

Image Resizing and Rotating Modes
Image Resizing Mode

Drag an arrow to resize
the image.

The arrows display
when the mouse is
positioned over the
Click this Image.
to display
apop-up Click this to change to
menu. rotating mode.

Change the text box format
Right-click a text box and
select [Change Frame] from
the pop-up menu.

Image Rotating Mode

Drag an arrow to
rotate the image.

¥ 1

L &

Click this  Click this to change
to display  to image resizing
apop-up  mode.

menu.
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Setting the Image Size for Printing
Fixed Photo Size

Images can be printed at standard photo print size.
Since the images are printed without gaps between them, they look like photo prints
when they are cut with a cutter.

1. Click the [Album Settings] button in the PhotoRecord window.
The Album Settings dialog will display.

2. Inthe [Album Types] category, select [Fixed Photo Size Printing].
3. Set the photo size and click [OK].

Printing on Canon Perforated Paper

The [Canon Perforated paper printing] option will be selectable in the Album Settings
dialog if you are using a Canon BJ printer that supports Canon Perforated Paper
media. Canon Perforated Paper has perforations at the preset dimensions allowing
you to print at the specified size and simply tear along the perforated lines to produce
an image with the appearance of a finished photo print. Please consult the BJ Solution
Disk User’s Guide for more details.

Printing from PhotoRecord from Windows NT 4.0/Windows 2000

« If the printer name is too long, you may not be able to print from PhotoRecord.
Shorten the name to enable printing.

1. Click the Windows [Start] menu and select [Settings] and [Printers].

2. Click the printer name twice with a slight pause between clicks. Input a new
name that is 31 characters or less. If the printer is a network printer, include the
path name in the 31-character count.
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Shooting with RemoteCapture

RemoteCapture will start if you click the ZoomBrowser EX [Edit] menu and select

[RemoteCapture] when the camera is connected to the computer via a USB port.

RemoteCapture lets you activate the camera’s shutter button remotely from the computer.

The captured image is automatically saved into the currently selected ZoomBrowser EX folder.

« RemoteCapture can only shoot still images.

« If an EOS D30 camera is connected via a USB port, clicking the shutter button on the
camera also downloads the image directly to the computer.

RemoteCapture Window

Thumbnail View —— Number of Frames that g
Displays thumbnails of all the images shot in the Can Be Captured o)
current session since RemoteCapture was started. Displays the number of 'g
images that can be saved —
RErrer e I - =11 to the computer or the ;
i - ) camera’s CF card.
- ] 15038 Displays the distribution
- + of brightness data.

Full View | Settings | Cqanected to Camera

] . Lo
| == wme=————— Displays the location in

f & which files are saved.
\ - Mj s (£ p. 36)
o “ A |Gacs Control Buttons

iy ¢~ 90 degres

_ o ) | P These buttons control
y [0t é the basic RemoteCapture
vt i o | functions. (O p. 34)
P acameter
Contrast  Hormal
Sharpness  Neemal
Color satucstion Normal e |
— | . .
(coman L= Displays the image
L ] H H
CA\Program File fyCanor\ZoomBrowser Ex\mage Likrany One\My Images\Capture_00001.JPG [ [ [ [ InfOFmatlon.
Image View — Allows you to add
Displays the image selected in the Thumbnail View. comments to images.

How to Start RemoteCapture Instead of Displaying the Camera Window

The settings can be changed so that ZoomBrowser EX automatically starts
RemoteCapture instead of its Camera Window when the camera is connected to
the computer’s USB port.

(1) Click the ZoomBrowser EX [File] menu and select [Preferences].

(2) In the Preferences dialog, click the [AutoStart] tab and set [Automatic Start

Options] to [RemoteCapture].

The RemoteCapture window will now show instead of the ZoomBrowser EX Camera
Window when the camera is connected to the USB port and starts ZoomBrowser EX.
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About the RemoteCapture Control Buttons
The control buttons are used to shoot, delete and display images.

rary Orel Click here to trigger the camera and take a shot. The
image is automatically saved to the computer.
=3 Pushing the camera’s shutter button directly will also save
R the image to the computer. (Supported by EOS D30 only)

| @0 Rotates the image saved to the computer by 90 degrees either way.
Crme T [ Select one of these to automatically rotate and save images shot
» with the camera swiveled from a horizontal to a vertical orientation.
% | Displays the image selected in the Thumbnail View in the Viewer.
i L ——— Deletes the image selected in the Thumbnail View. Please take
Ll | proper caution before deleting because deleted images are

completely erased from the computer in one step with this button.

Using Interval and Timer Shooting

RemoteCapture can be used to shoot a set number of images at specified intervals
(Interval Shooting) or to shoot an image after a specified delay (Timer Shooting).

Interval Shooting
You can set the number of frames and the interval at which they are shot.

1. Click the [File] menu and select [Interval Shooting].
The Interval Shooting dialog will display.

2. Set the number of frames and interval value and click [OK].

RemoteCapture will start interval shooting, capturing the specified number of
images at the specified intervals.

Timer Shooting
You can set the time delay before an image is shot.

1. Click the [File] menu and select [Timer Shooting].
The Timer Shooting dialog will display.

2. Set the number of seconds and click [OK].
RemoteCapture will start timer shooting, capturing an image after the specified
delay.

Printing a Thumbnail Index Sheet

Thumbnails you select in the Thumbnail View can be printed in order on a single index
sheet by clicking the [File] menu and selecting [Print Index]. Since the file name and
shooting date and time can be printed with each image, index sheets serve as a
convenient record of and reference for your images.
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Precautions when Shooting with RemoteCapture

« If your computer is set to go into standby mode, there is no guarantee that
RemoteCapture will continue to function after the computer has entered standby
mode. Always turn off the standby function before you start shooting with

RemoteCapture.

= The camera’s auto power save setting is disabled while connected to RemoteCapture,
and the power remains on until manually turned off. You are recommended to
power the camera with a household power source while it is connected.

« Please note that the camera will not be able to shoot at the specified interval if it is
shorter than the time required to send the image and save it on the computer.

« If the camera is set for “mirror lockup™ shooting, the shutter will activate
approximately two seconds after the release button is clicked in RemoteCapture.

(Supported by the EOS D30 only)

Setting Basic Shooting Settings in RemoteCapture
The camera’s shooting settings can be adjusted by clicking the [Shooting Settings] tab

in the RemoteCapture window.

Windows

Please adjust the shooting settings for the EOS D30 on the camera itself.

Image ‘Wiew | ek Settng.
=

Teet Shot 1

SizesQuality ILargeﬁ'Fine

Flash |suto

Macro IOﬂ

White Balance IAuto

Exposuren ID
Compensation

Lo el el 1]

Test Preview
A preview of the test shot displays.

Sets the camera’s zoom setting.

Test Shot
Takes a test shot.
Test shots are not saved to the computer.

Basic camera settings can be adjusted.
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Changing the Save Location and Other Preferences

The Preferences dialog can be opened by clicking the RemoteCapture [File] menu
and selecting [Preferences]. This dialog can be used to change the save location and

settings.
]
File Setlings | Release Hotkey|
Save Images On
Selects whether the image is saved only ————— & g i
on the computer or on the camera’s CF ® EFeaE} HECEE)
card too.

File Prefix [Up ta 16 characters]

Sets the image file prefix. If the prefixis —————Fsws
set to [Capture], for example, the first

|mage W|" be namEd [Capture_00001.jpg] Folder to which Images are Downloaded
and successive |mages Wl” have hlgher C:\Program FileshCanon'ZoomBrowser ExX\mage Library Onet
numbers. =] Canon =l
[ PhotoStitch
. . . . | ] RemoteCapt
Sets the folder in which the image file —————— T Zomtroe £
is saved. L Progiam
£ CameraBitmaps J
] Database
5 Image Library One j
|

Selects a drive on the computer. - N Foldet.

aK Cancel Lpply
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Converting RAW Images

The RAW format records the image data as captured by the camera’s image sensor
without further processing by the camera. Although the data is compressed when
recorded, the original data can be completely restored without any loss of quality, making it
possible to obtain high-quality images. Moreover, the RAW image file format is extremely
compact, creating files that are approximately one-third to one-quarter the size of an
uncompressed file (RGB TIFF). Please refer to your Camera User Guide to learn how to set
the camera to shoot in the RAW format.

The process of obtaining high-quality RGB signals from RAW format images (hereafter
RAW images) is called ““‘conversion.” Since ZoomBrowser EX can be used to adjust the
attributes of the original data, you can achieve the effects you wish while maintaining high
image quality. In contrast, image data recorded in the RGB TIFF and other standard
uncompressed file formats is irrevocably processed in the camera and must be further
processed irrevocably by retouching software to change the attributes, which reduces the
image quality.

Please note that ZoomBrowser EX or the TWAIN Driver are required to load RAW images
onto a computer.

Windows

Converting RAW Images without Adjusting the Quality
1. Select a RAW image from the Browser Display Area of ZoomBrowser EX.

2. Click the [File] menu and select [Convert RAW Images].

The image is converted and saved in a new TIFF (8 bits/channel) file. To learn how
to change the file format, please see “How to Change the File Format.” (O p. 38)

Converting RAW Images with Quality Adjustment
1. Select a RAW image from the Browser Display Area of ZoomBrowser EX.

2. Click the [File] menu and select [Convert RAW Images with User
Defined Parameters].
The RAW Image Parameter Settings dialog will display.

3. Select the quality settings and click [OK].
The RAW image is converted according to the specified parameters and saved in
a new TIFF (8 bits/channel) file. If multiple RAW images are selected, the
parameters are applied only to the first image. When only one RAW image is
adjusted, the changes are also reflected in the remaining images in the selection.
To learn how to change the file format, please see ““How to Change the File
Format.” (O p. 38)
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RAW Image Parameter Settings Dialog

Click this and a white point of the Preview Area
image in the Preview Area to set it I
as the Va|ue for the Wh|te ba|ance. ’;:ERaw\magePauamexeysEnmg dialog is used lo set the corversion para) weters for the RAW image
. ) ‘white Balance
Parameter setting selections are — 2

reflected in the preview image.

Placing a check here applies
linear processing to the
contrast, sharpness and color
saturation, and allows the
images to be edited with
photo retouching software,
such as Adobe Photoshop. shoningstings | [0 | | Cawl |
< The [Linear] option is only i

enabled when [TIFF 16 bits/ Displays the image in the Resets the image quality

channel] is selected as the Preview Area at full size. settings to the state in which

file format. the image was shot.

Selecting and Adjusting the Attributes of Multiple RAW Images

Ensure that all images included in a multiple selection of RAW images are from the
same camera before attempting to adjust the image attributes. The white balance
will not adjust properly if images from different cameras are mixed and the [Manual]
white balance option is selected in the RAW Image Parameter Settings dialog or if a
white portion of the image is selected in the preview area.

How to Change the File Format

1. Click the ZoomBrowser EX [File] menu and select [Preferences].
The Preferences dialog will display.
2. Change the format in the Image Format tab and click [OK].

Saving in the TIFF 16 Bits/Channel Format

When [TIFF 16 bits/channel] (supported by the EOS D30 only) is selected as the file
format for saving RAW images, 16 bits of data is used to record each RGB channel.
This image format can be used in several application programs, such as Adobe
Photoshop LE. Formats other than TIFF 16 bits/channel all save the image using 8
bits per RGB channel.

Restore the Database

The database file may become corrupted if a system crash occurs for some reason
when ZoomBrowser EX is being run at the same time as another software program.
If this occurs, start ZoomBrowser EX again, click its [File] menu and select [Restore
Database]. The database file will automatically be restored.
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Loading Images with
TWAIN-Compliant Programs

This section explains how to load images with TWAIN-compliant application programs, such
as ArcSoft Photolmpression, Adobe Photoshop and Adobe PhotoDeluxe Home Edition.

Using ArcSoft Photolmpression
Installing the Software
Installing the TWAIN Driver

This program is required to load camera images into TWAIN-compliant application
programs. For instructions, see “Installing/Uninstalling the Software” (OI p. 7) or
“Installing the USB Driver” (O p. 9).

Installing ArcSoft Photolmpression

Insert the ArcSoft CD-ROM in the drive and double-click the [My Computer] icon on
the desktop followed by the [ArcSoft] folder and [Setup.exe] icon. Follow the on-
screen instructions to install the program.

Starting the Software
Connecting the Camera to a USB Port

1. Connect the camera to the computer’s USB port.

Refer to Where to Find Instructions for Attaching Your Camera to a
Computer (O p. ii) for connection instructions.

2. Set the camera to the mode for communicating with a computer.

After a moment, an event dialog will allow you to select an application program
to start.

3. Click the [Start] menu and select [Programs], [ArcSoft Camera Suite]
and [Photolmpression].
ArcSoft Photolmpression will start.

Click the [Get Photo] button.
Click the [Camera/Scanner] button.

Select your camera model name from the [Select Source] option and
click the |52/ button.
The TWAIN driver will start (O p. 45).

Windows
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Connecting via a CF Card Reader or PC Card Slot

1. Place the CF card into the CF card reader or into the PC card adapter
and then into the PC card slot.

Refer to Where to Find Instructions for Attaching Your Camera to a
Computer (O p. ii) for connection instructions.

2. Click the [Start] menu and select [Programs], [ArcSoft Camera Suite]
and [Photolmpression].
ArcSoft Photolmpression will start.

Click the [Get Photo] button.
Click the [Camera/Scanner] button.

5. Select your camera model name from the [Select Source] option or
select [Canon Digital Camera RS-232C] and click the % button.
The TWAIN Driver will start.

Connecting the Camera to a Serial Interface

1. Attach the camera to the computer with the serial cable.

Refer to Where to Find Instructions for Attaching Your Camera to a
Computer (O p. ii) for connection instructions.

Set the camera to the mode for communicating with a computer.

Click the [Start] menu and select [Programs], [ArcSoft Camera Suite]
and [Photolmpression].
ArcSoft Photolmpression will start.

Click the [Get Photo] button.
Click the [Camera/Scanner] button.

Select [Canon Digital Camera RS-232C] from the [Select Source] option
and click the 52 button.
The TWAIN driver will start.

Click the [Communication Settings] button.

Set the port type, port name and baud rate (transfer speed) settings
and click the [OK] button.
For instructions on the communication settings, please refer to page 101.

For downloading instructions, please see Loading Images (O p. 47).
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Using Adobe Photoshop LE

Installing the Software
Installing the TWAIN Driver

This program is required to load camera images into the TWAIN-compliant application
programs. For instructions, see “Installing/Uninstalling the Software” (O p. 7) or
“Installing the USB Driver” (O p. 9).

Installing Adobe Photoshop LE

Place the Adobe Photoshop LE CD-ROM in the drive, double-click [My Computer] on
the Windows desktop, followed by the [Photosle] CD-ROM icon, the [English] and
[Photosle] folders, and the [Setup.exe] file. Follow the on-screen instructions to
complete the installation.

Windows

You must input the software serial number to install Adobe Photoshop LE.
It can be found on the CD-ROM case.

Starting the Software
Connecting the Camera to a USB Port

1. Connect the camera to the computer’s USB port.

Refer to Where to Find Instructions for Attaching Your Camera to a
Computer (O p. ii) for connection instructions.

2. Set the camera to the mode for communicating with a computer.

After a moment, an event dialog will allow you to select an application program
to start.

3. Select Adobe Photoshop LE and click [OK].
Adobe Photoshop LE will start.

4. Click the Adobe Photoshop LE [File] menu and select [Import] and
[Select TWAIN_32 Source].

5. Choose your camera model and click [Select].

6. Click the [File] menu and select [Import] and [TWAIN_32]
The TWAIN Driver will start (O p. 45).
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Connecting via a CF Card Reader or PC Card Slot

1. Place the CF card into the CF card reader or into the PC card adapter
and then into the PC card slot.

Refer to Where to Find Instructions for Attaching Your Camera to a
Computer (O p. ii) for connection instructions.

2. Click the Windows [Start] menu and select [Programs], [Adobe],
[Photoshop Limited Edition] and [Adobe Photoshop Limited Edition].
Adobe Photoshop LE will start.

3. Click the [File] menu and select [Import] and [Select TWAIN_32 Source]

4. Choose an appropriate source and click [Select].

Select either [Canon XXX USB], where the XXX represents your camera model
name, or [Canon Digital Camera RS-232C] as the source as appropriate.
If several models are listed, select the one that corresponds to your camera.

5. Click the [File] menu and select [Import] and [TWAIN_32]
The TWAIN Driver will start.

Connecting the Camera to a Serial Interface

1. Attach the camera to the computer with the serial cable.

Refer to Where to Find Instructions for Attaching Your Camera to a
Computer (O p. ii) for connection instructions.

2. Set the camera to the mode for communicating with a computer.

3. Click the Windows [Start] menu and select [Programs], [Adobe],
[Photoshop Limited Edition] and [Adobe Photoshop Limited Edition].
Adobe Photoshop LE will start.

4. Click the [File] menu and select [Import] and [Select TWAIN_32 Source]
5. Choose [Canon Digital Camera RS-232C] and click [Select].

6. Click the [File] menu and select [Import] and [TWAIN_32]
The TWAIN Driver will start (O p. 45).

For downloading instructions, please see Loading Images (O p. 47).
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Using Adobe PhotoDeluxe Home Edition
Installing the Software
Installing the TWAIN Driver

This program is required to load camera images into the TWAIN-compliant application
programs. For instructions, see “Installing/Uninstalling the Software” (O p. 7) or
“Installing the USB Driver” (O p. 9).

Installing Adobe PhotoDeluxe Home Edition

Place the Adobe PhotoDeluxe Home Edition CD-ROM in the drive, click [ReadMe &
Guide] and [Install Guide] in the window that displays.

The serial number shown during installation will be required for the user
registration process.

Windows

Starting the Software
Connecting the Camera to a USB Port

1. Connect the camera to the computer’s USB port.

Refer to Where to Find Instructions for Attaching Your Camera to a
Computer (O p. ii) for connection instructions.

2. Set the camera to the mode for communicating with a computer.

After a moment, an event dialog will allow you to select an application program
to start.

3. Select [PhotoDeluxe Home Edition] and click [OK].

Adobe PhotoDeluxe Home Edition will start and open the TWAIN driver. Use the
TWAIN driver to load images. (O p. 45)

Connecting via a CF Card Reader or PC Card Slot

1. Place the CF card into the CF card reader or into the PC card adapter
and then into the PC card slot.

Refer to Where to Find Instructions for Attaching Your Camera to a
Computer (O p. ii) for connection instructions.

2. Start Adobe PhotoDeluxe Home Edition.

3. Click [Get & Fix Photo] at the upper left of the window.
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4. Click [Get Photo] from the icons that display and select [Cameras].

5. Click the [1 Camera] tab.

In the [Camera Models] option, confirm that [Canon XXX USB] (XXX will be replaced
by your camera model hame) or [Canon Digital Camera RS-232C] is selected. If
several models are listed, select the one that corresponds to your camera.

6. Click the [Open Camera] button.
The TWAIN driver will start. Use it to load images. (O p. 46)

Connecting the Camera to a Serial Interface

1. Attach the camera to the computer with the serial cable.

Refer to Where to Find Instructions for Attaching Your Camera to a
Computer (O p. ii) for connection instructions.

Set the camera to the mode for communicating with a computer.
Start Adobe PhotoDeluxe Home Edition.
Click [Get & Fix Photo] at the upper left of the window.

Click [Get Photo] from the icons that display and select [Cameras].

o 0k~ W N

Click the [1 Camera] tab.

In the [Camera Models] option, confirm that [Canon Digital Camera RS-232C] is
selected.

7. Click the [Open Camera] button.
The TWAIN driver will start.

8. Click the [Communication Settings] button.

9. Set the port type, port name and baud rate (transfer speed) settings
and click the [OK] button.
For instructions on the communication settings, please refer to page 102.

For downloading instructions, please see Loading Images (O p. 47).
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Guide to the TWAIN Driver Window

Preferences Button ——— Rotate 90 Degrees Buttons — Set RAW Param. Button
Displays and changes the image Rotates the selected image Sets the image quality
transmission settings. (O p. 51) left or right 90 degrees. settings for RAW images
O p. 49
Camera Settings Button (0 p-49)
Adjust or check camera Display Style Buttons
settings. (O p. 14)
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DN e (%2 J—Help Button

Browse ———————————— Thumbnail Yiew File View

Windows

4| | ]
Main Buttons Thumbnail Display Area
These buttons control the main commands, Image thumbnails display here when the
such as those for loading images and exiting camera is connected.

the TWAIN driver.
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Loading Images

The TWAIN Driver can display still images only. Please start ZoomBrowser EX to download
movies to the computer.

Downloading Images from the Camera

1. Click the [Camera] button.
The camera images will appear in the Thumbnail Display Area.

2. Select the images you wish to download and click the [Acquire]
button.

The images will appear in the ArcSoft Photolmpression, Adobe Photoshop LE or
Adobe PhotoDeluxe window.

3. Click the [Exit] button to close the TWAIN Driver.

To save the loaded images, click the [File] menu of the image editing software
and select [Save As]. (Adobe PhotoDeluxe users should click the [File] menu and
select [Output] and [File Format] to save the images.) Input a file name and
change the file location and format settings as required.

Downloading Images Directly from a CF Card

1. Double-click the TWAIN Driver’s [My Computer] button.
The My Computer dialog will open.

2. Select the folder containing the images and click [OK].
The CF card images will display in the Thumbnail Display Area.

3. Select the images you wish to download and click the [Acquire] button.

The images will appear in the ArcSoft Photolmpression, Adobe Photoshop LE or
Adobe PhotoDeluxe window.

4. Click the [Exit] button to close the TWAIN Driver.
To save the loaded images, click the [File] menu of the image editing software
and select [Save As]. (Adobe PhotoDeluxe users should click the [File] menu and
select [Output] and [File Format] to save the images.) Input a file name and
change the file location and format settings as required.
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Downloading Images with Windows Me via WIA driver

If you have installed the WIA Driver for Windows Me, you can use the following
procedures to download images very easily.

» Using the Scanners and Cameras Wizard
1. Connect the camera to the computer’s USB port.
The Scanners and Cameras Wizard will automatically appear.
2. Follow the on-screen instructions to download images to the computer.

« Using Windows Explorer
1. Connect the camera to the computer’s USB port and start Windows Explorer.
2. Select the icon of your camera, which will appear in the left portion of
Windows Explorer.
The camera images will show as thumbnails in the right portion.
3. Copy the image files to the computer’s hard drive using standard Windows
Explorer techniques.

Windows

« Using the File Dialog

1. Connect the camera to the computer’s USB port and start an image editing
application, such as ArcSoft Photolmpression or Adobe Photoshop LE.

2. Click the [File] menu and select [Open].
The File dialog will appear.

3. In the File dialog, select the icon of your camera.
The camera images will show as thumbnails in the dialog.

4. Select the images you wish to download and click the [Open] button.
The images will appear in the application’s window.
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Setting the Parameters (EOS D30 Only)

Up to three sets of parameters for loading images can be set in the TWAIN Driver using
the Parameter Settings dialog in addition to the parameters already set on the camera.
Please see the Camera User Guide to learn how to select the parameters for the camera
that are set with the computer.

1. Click the [Camera Settings] button in the TWAIN Driver window.
The Camera Settings dialog will display.

2. Click the [Parameters] button.
The Parameter Settings dialog will display.

3. Click [Add Set].
4. Set each parameter.

5. Click [Apply to Camera].
The settings will be applied to the camera.

Parameter Settings Dialog

Parameter Settines

Thiz dialog can be used to set the parameter settings for the camera's
creative zone.
Parameter gete labeled Set]-Setd can be applied to camera

& Sl | Stz |
Canfrast: -I—j—l Narmal
Sets the VanOUS Sharpness: .I—J—I Marmal
arameters. . ‘ .
p Color Saturation .—J— Marmal
Loads the contents Of a Load Settings | Save Settings | Apply to Camera I
parameter set saved to the
computer’s hard disk. | DelteSel | Clse |
Click here first to add a new — )
parameter set to the camera. Applies the current
Saves the parameter parameter set to
set to the computer. the camera.

To load the saved
parameter set, click
[Load Settings].
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Converting RAW Images

The RAW format records the image data as captured by the camera’s image sensor
without further processing by the camera. Although the data is compressed when
recorded, the original data can be completely restored without any loss of quality, making
it possible to obtain high-quality images. Moreover, the RAW image file format is
extremely compact, creating files that are approximately one-third to one-quarter the size
of an uncompressed file (RGB TIFF). Please refer to your Camera User Guide to learn how
to set the camera to shoot in the RAW format.

The process of obtaining high-quality RGB signals from RAW format images (hereafter
RAW images) is called “conversion.” Since TWAIN Driver can be used to adjust the
attributes of the original data, you can achieve the effects you wish while maintaining
high image quality. In contrast, image data recorded in the RGB TIFF and other standard
uncompressed file formats is irrevocably processed in the camera and must be further
processed irrevocably by retouching software to change the attributes, which reduces the
image quality.

Please note that ZoomBrowser EX or the TWAIN Driver are required to load RAW images
onto a computer.

Windows

Converting RAW Images without Adjusting the Quality

1. Select a RAW image from the Thumbnail Display Area of the TWAIN
Driver window.

2. Click the [Acquire] button.
The image will be converted and sent to softwares such as Adobe Photoshop LE
at 8 bits per RGB.
To learn how to change the file transmission format, please see “How to Change
the File Transmission Format.”(d p. 51)

Converting RAW Images with Quality Adjustment

1. Select a RAW image from the Thumbnail Display Area of the TWAIN
Driver window.

2. Click the TWAIN Driver [Set RAW Param.] button.
The RAW Image Parameter Settings dialog will display.

3. Select the quality settings and click [OK].
When an image is adjusted, the “RAW” symbol shown on its thumbnail will
change from gray to green. If multiple RAW images are selected, the parameters
are applied only to the first image. When only one RAW image is adjusted, the
changes are also reflected in the remaining images in the selection.
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4. Click the [Acquire] button.
The RAW image will be converted according to the specified parameters and the
data will be sent to softwares such as Adobe Photoshop LE at 8 bits per RGB
channel.
To learn how to change the file transmission format, please see “How to Change
the File Transmission Format™ (O p. 51).

Converting RAW images with Windows Me installing WIA driver

RAW images can be converted with the following procedures.
« Converting a RAW Image on a Camera’s CF Card
1. Select the RAW image in the Windows Explorer
2. Right-click the mouse and select [Preview] to start the RAW image utility.
3. Set the file format and save the image to the computer.
« Converting a RAW Image on the Computer’s Hard Drive
1. Double-click the RAW image in the Windows Explorer to start the RAW image
utility.
2. Set the file format and save the image.



RAW Image Parameter Settings Dialog
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< The image quality settings are restored to the default settings when the TWAIN Driver
is closed. The settings are also restored to the default settings when the connection
with the camera is broken off, if an image is recorded or deleted by the camera while
connected to the computer, or if the TWAIN Driver window is refreshed.

Selecting and Adjusting the Attributes of Multiple RAW Images

Ensure that all images included in a multiple selection of RAW images are from the
same camera before attempting to adjust the image attributes. The white balance
will not adjust properly if images from different cameras are mixed and the [Manual]
white balance option is selected in the RAW Image Parameter Settings dialog or if a
white portion of the image is selected in the preview area.

How to Change the File Transmission Format

1. Click the [Preferences] button in the TWAIN Driver window.
The Preferences dialog will display.

2. Change the transmission format in the [Send RAW image data to the
application] option and click [OK].

Transmitting in the TIFF 16 Bits / Channel Format

When [16 bits per color channel] (supported by the EOS D30 only) is selected as the
transmission option for RAW images, images can be transmitted to the application at 16
bits per RGB channel. Although colors are expressed more vividly with the 16-bit setting
than the 8-bit setting, the file size increases dramatically. Moreover, some image editing
applications function only partially with files of this format or cannot open them at all.

2
o
S
=
=




52 |
Troubleshooting the USB Driver Installation

Check This First

1. Is the camera connected to the computer correctly?

Refer to Where to Find Instructions for Attaching Your Camera to a
Computer (O p. ii) for connection instructions.

Is the camera power on?

3. Is the battery charge sufficient?

We suggest that you use the AC adapter to power a camera connected to a
computer.

[

You will not be able to check the USB driver status if there is a problem with any of the
items above.

If the ““Add New Hardware Wizard” (in Windows 2000 it is the “Found New Hardware
Wizard”) appears while performing any of the steps above, click the wizard’s [Cancel]
button, disconnect the camera and computer, and reinstall the USB driver using the
procedures in the Installing the USB Driver section (O p. 9).

If the three potential problems above are OK, first uninstall the USB driver with the
procedures below before reinstalling it according to the instructions in the Installing the
USB Driver section. (O p. 9)

Refer to the “Installing and uninstalling the WIA driver” to uninstall the
WIA driver (O p. 10).

Uninstalling the USB Driver from Windows 98
Check the USB Driver Status

« Does your camera model name or icon appear in the “Scanners and Cameras
Properties dialog in Windows 98 or Windows 2000, or the [Scanners and
Cameras] folder in Windows Me?

Display the ““Scanners and Cameras Properties™ dialog with the following steps.
1. Connect the camera to the computer with the USB cable.

2. Click the [Start] menu and select [Settings] and [Control Panel].

3. Double-click the [Scanners and Cameras] icon or folder.

Devices | Logging sefings |

aaaaaaaaaaaaaaaaaaaaaaa talled

Check to see if your camera model appears here.
The names of scanners and other devices for which
drivers have already been installed will show in this
window.

add Berove Propetiss

Cancel

In Windows Me, the name of the installed cameras or scanners will display.
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If your camera name appears in the Scanners and Cameras Properties window, use the
following procedures to delete it.

Windows 98/2000
- Select the name of your camera and click the [Remove] button.

Windows Me
- Select the name of your camera, right-click the mouse and select [Remove].

Then follow the procedures described in Step 3 and after in P.53.

What to Do if Your Camera Model Name Is Not in the “Scanners
and Cameras Properties” Device List or if the [Scanners and
Cameras] Icon Is Not in the Control Panel

Windows 98/Windows Me

3a.

3b.

Windows

Double-click the [System] icon in the Control Panel and check the
[Device Manager] tab.

1. Double-click the [System] icon in the Control Panel.

2. Click the [Device Manager] tab.

Check the [Other devices] or [Imaging Devices] categories for an item
corresponding to your camera model. Delete it with the following procedures.

tiollers
ontrollers

-l Network adapters
&l Ports (COM & LPT)
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1. Select the item corresponding to your camera model and click the [Remove] button.
2. Click the [OK] button in the confirmation dialog.
3. Click the [OK] button to close the ““System Properties™ dialog.

If you installed the software with the installer, then connected the
camera to the computer and installed the USB Driver:

Click the [Start] menu and select [Programs], [Canon Utilities], [Digital Camera
USB Driver] and [USB Driver Uninstall]. The uninstallation process is complete.

If you connected the camera to the computer with the USB interface and
installed the USB Driver before installing the software with the installer:
Follow the procedures from Step 4 below.
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4. On the Windows desktop, double-click the [My Computer] icon, [C:]
icon, [Windows] folder, and [Inf] folder in succession.

What to Do if the [Inf] Folder Is Not Visible in the [Windows] Folder

« Follow the procedures below to set the folder options to the “Show all files” setting.
1. Click the [View] menu and select [Folder Options].
2. Click the [View] tab.
3. In the [Hidden files] category, select [Show all files].
4. Click the [OK] button to close the “Folder Options™ dialog.
This will show all the previously hidden files.

View Go Favortes Hek Folder Options 2]
Lzl > Berwral View | Fie Types|

v Status Bar
Explorer Bar 3

~Folder

You can make all your foldets look the same.

lee[uueanu\delI Beset Al Folders |

v @ WebPage

® Lagelcons
Small lcons
List
Detalk

Advanced setlings:
Remeniber each folder's view settings =
[ Display the ful path in tile bar
Hide file extensions for known fils ypes
Amange leons » [ Show Map Network Diive button in taobar
Line Up leons [ Show file attibutes in Detail View

Show pap-up deseiption for folder and deskiop items

e 3 #low all uppercass names
O Laalabigr hidden or systern files =
0t shov Mgen filss
Restore: Defaults
( ok I tancel Apply

Customize this Folder.

5. Find and delete the [Drvdata.bin] and [Drvidx.bin] files.

Drvidx.bin

The [Inf] folder contains numerous files. Ensure that you double-check
the file names before you delete any files. Deleting the wrong file may,

in the worst case scenario, result in the failure of your computer to run
the Windows operating system.

6. Double-click the [Other] folder inside the [Inf] folder.

7. Find and delete the [Canon.IncCanon_DC], [Canon.IncCanonDC1] or
[Canon.IncCanonDC2] file.
B Skip this step if this file is not present in the [Other] folder.
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Windows 2000

Log onto Windows 2000 as an Administrator before uninstalling the USB driver.

1. Open the System Properties dialog and check the Device Manager tab.
1. Double-click the [System] icon in the Control Panel.
2. Click the [Hardware] tab, followed by the [Device Manager] button.

2. Check the [Other devices] or [Imaging Devices] categories for an item
corresponding to your camera model. Delete it with the following
procedures.

General Devics Manager | Hardwate Profies | Performance | General Device Manager | Hardware Profiles | Perfomance

@ Viewdevicssbytpe View devices by conmestion @ Viswdevices bytpe View devices by cornection

Windows

1. Select the item corresponding to your camera model and click the [Remove]
button.

2. Click the [OK] button in the confirmation dialog.

3. Click the [OK] button to close the ““System Properties™ dialog.

3a. If you installed the software with the installer, then connected the
camera to the computer and installed the USB Driver:
Click the [Start] menu and select [Programs], [Canon Utilities], [Digital Camera
USB Driver] and [USB Driver Uninstall]. The installation process is complete.

3b. If you connected the camera to the computer with the USB interface and
installed the USB Driver before installing the software with the installer:
Follow the procedures from Step 4 below.

4. On the Windows desktop, double-click the [My Computer] icon, [C:]
icon, [Windows] folder, and [Inf] folder in succession.
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What to Do if the [Inf] Folder Is Not Visible in the [Winnt] Folder

1. Open the [Winnt] folder.

2. Click the [Tools] menu and select [Folder Options].

3. Click the [View] tab.

4. In the [Advanced Settings] category, find the [Hidden Files and Folders]
subcategory and select [Show hidden files and folders].

5. Click the [OK] button to close the “Folder Options” dialog.

This will show all the previously hidden files and folders.

Tecs oe)

General View | File Types | Dffine Fes |

hap Metwork Drive:
Disconnect Mebwork Drive...
Synchionize

~Folder

“You can set allof your folders to the same view
Like Current Folder Fieset All Folders

Folder Dptions...

o
N Restore Defaults

( 0K am:e Apply
N—

5. Look for files starting with [Oem™*].
A number such as 0 or 1 will appear in place of the “*”after the “Oem” prefix
in the file name.
For each [Oem™*] file there is a companion [Oem™*.pnf] file with the same
number following the “Oem” prefix (e.g. the OemO and OemO.pnf files form
one set of Oem files).
» Please note that numerous groupings of “Oem” files may be present in the

[Inf] folder. Do not delete the wrong files.

6. Search for the [Oem*] files for Canon digital cameras.

Double-click a file to open it in the Windows Notepad accessory and look for
[;*** Canon Digital Camera USB Setup File ****] in the first line. If you find it,
note down the file name and close Notepad.

7. Delete the [Oem*] file and corresponding [Oem*.pnf] file.
Ensure that you have the correct files before deleting them.

The [Inf] folder contains numerous files. Ensure that you double-check
the file names before you delete any files. Deleting the wrong file

may, in the worst case scenario, result in the failure of your computer
to run the Windows operating system.
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Introducing the Software

This section introduces the powerful software programs for the Macintosh platform
contained on the CD-ROM included with the camera.

Canon Digital Camera Solution Disk

Some camera models do not support some of the software functions. Please
check the Camera and Software Compatibility chart to confirm the compatibility
of your camera. (O p. 61)

ImageBrowser

To load camera images, start ImageBrowser.

Camera Connection Functions
(Also effective for CF card readers or PC card readers)
< Displays camera images.
« Downloads still images and movies from the camera to the computer.
 Loads and saves RAW images in the RAW format.
« Converts and saves RAW images in other formats.
« Saves computer images to a CF card in the camera.
« Edits the print order settings (DPOF-compliant settings) of images on a CF card.
« Edits slide shows for replay on the camera.
< Connecting to a USB port automatically starts ImageBrowser and displays the
camera images.
« Sets the camera parameters.

Image File Management Functions

« Displays, moves, copies or deletes images stored on computer disks.

= Allows simple editing procedures, such as image color adjustments and cropping.

« Displays all the files in a specified folder at once.

« Displays files in chronological order in a window that looks like a time tunnel.

» Replays images from the computer one-by-one at full screen size to simulate a
slide show.

Image Printing Functions
« Prints multiple images on the same page.

« Allows you to freely resize images and change layouts.
 Allows you to place titles or captions anywhere on the page.

Supports PhotoStitch Panoramas
« Allows you to select camera images or images registered with ImageBrowser and

start PhotoStitch from within ImageBrowser to merge a series of images into a
panorama in a few simple steps.
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Supports ArcSoft Photolmpression, Adobe Photoshop LE or
PhotoDeluxe

« Allows you to select images registered with ImageBrowser and start one of these
photo-retouching programs from within ImageBrowser to edit and apply special
effects to your images.

Adjusting Images for Transmission by E-mail

« Allows you to adjust image size and compression settings so that large image files
can be made smaller for transmission as e-mail attachments.

PhotoStitch

« Effortlessly merges images that are shot over several frames with a camera.

< Automatically arranges images shot in Stitch Assist mode into the correct order and
effortlessly merges them.

« Merges any number of images horizontally or vertically, or in a matrix format.

» Makes images with straight lines appear natural not crooked when merged. (Select
the wide display format.)

« A 360-degree scene shot in several frames can be merged into a 360-degree image
and saved in the QuickTime VR format, making it appear as if you were standing in
the middle of the image looking about in all directions.

RemoteCapture

« Connecting via a USB port allows you to release the camera’s shutter button from
the computer. The images load directly into the computer.

« Connecting via a USB port also allows you to load images directly into the computer
by clicking the camera’s shutter button.

« Allows interval shooting with custom interval and frame settings.

Plug-In Module

Canon Digital Camera Plug-In Module

Macintosh

The Plug-In Module is the driver utility program that works within plug-in
compliant application programs, such as Adobe Photoshop LE or Adobe
PhotoDeluxe, to load camera images directly into the application program. The
Plug-In Module is started from within the plug-in compliant application program.
It cannot be used as a stand-alone program.

Apple QuickTime
« Installing Apple QuickTime allows you to replay the movies you shot or view images
in the QuickTime VR format that you merged with PhotoStitch.



ArcSoft Camera Suite CD-ROM*

ArcSoft Photolmpression
 Allows you to edit and apply special effects to images as well as effortlessly create

greeting cards and calendars.

ArcSoft Videolmpression

« Allows you to effortlessly edit and save movies, making it easy to integrate movie
clips and stills into a single movie or delete frames.

Adobe Photoshop LE CD-ROM*
Adobe Photoshop LE

« Allows you to edit images, apply special effects, print and create sophisticated
graphics for the web.

Adobe PhotoDeluxe Home Edition CD-ROM*

Adobe PhotoDeluxe Home Edition

 Allows you to edit images and effortlessly create greeting cards, birthday cards and
calendars.

* The retouching software bundled with cameras varies between camera
models. Some models are not bundled with retouching software. Please
refer to the System Map for the programs supplied with your camera.
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Camera and Software Compatibility

The Canon Digital Camera Solution Disk contains a number of software programs and
drivers. Check the chart below for the compatibility of your particular camera model with
each program’s special functions.

Model
PowerShot Series
I I I
e I S
(] [} i 8 >
2|2 (2|88 |83
218 2| 2|3 |alas|E|E|E
i Blelals|S|g|83|22|2|¢
Function Software m & | o | s | < | » |8 | » | oo | o
COmpUter USB(l) . . ° ° ° ° ° ° ° ° °
Interface  ggrial - . . . - - - - - - -
Downloading ImageBrowser . . . . . . . . . . .
Camera Images | Plug-In Module(
Downloading
Movies ImageBrowser - - - - -
RAW Image ImageBrowser . . . _ B B B B ~ _ _
Conversion Plug-In Module(@) %
2
Uploadmg |mageB|'0Wser . . . . . ° ° ° ° ° ° .E
Images to Camera o
s
Editing Camera
Slide Show ImageBrowser - o D D - - - - - - -
Editing Camera
Print Settings | MgeBroWser A R IR IR I I R R A R
Merging Images
Shot in Stitch PhotoStitch - @ o] . . . . . . .
Assist Mode
Shooting from 3
the Computer RemoteCapture®) | o . . - . - . o - o o

(1) Only compatible with Power Macintosh NEW G3/G4, PowerBook G3, iMac and iBook models
with built-in USB ports.

(2) Since ArcSoft Photolmpression and ArcSoft Videolmpression are not Plug-In compliant
programs, images cannot be downloaded via the Plug-In Module.

(3) Only compatible with the USB interface.

@) Images shot with the Wide Converter, Tele-converter or Close-up lens do not merge well in
PhotosStitch.
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System Requirements

The following system requirements must be met to install and operate the software.

—@ Computer Model

Power Macintosh, PowerBook, iMac or iBook
—@ OS
Mac OS 8.1 or higher, QuickTime 3.0 or a later version
(Not compatible with Mac OS X)

—@ CPU
PowerPC
: —-T—®RAM
— 20 MB or more of application memory
@ Interface
USB: (Power Macintosh NEW G3/G4, PowerBook G3,
‘ - iMac, iBook)

ﬁgw——% 5 « Limited to genuine Apple Computer brand
= : § models with a built-in USB interface

< iMac computers running Mac OS 8.1 require
installation of the “iMac Update 1.0” and
“iMac Firmware Update 1.0”
RS-422:  (Printer or modem port)

——@ Free Hard Disk Space
Canon Utilities

ImageBrowser: 20 MB or more

PhotoStitch: 30 MB or more

RemoteCapture: 15 MB or more
Canon Digital Camera Plug-In Module: 15 MB or more
Adobe Photoshop LE*: 40 MB or more
Adobe PhotoDeluxe*: 70 MB or more
ArcSoft Photolmpression™*: 120 MB or more
ArcSoft Videolmpression*: 30 MB or more

©® Display
Minimum: 800 x 600 pixels, 256 colors
Recommended: 1,024 x 768 pixels, thousands of colors
or more

Thousands of colors or more is required to use ArcSoft
Photolmpression or ArcSoft Videolmpression.

* The retouching software bundled with cameras varies between camera models. Some models
are not bundled with retouching software. Please refer to the System Map for the programs
supplied with your camera.

« A CD-ROM drive is required to install the software.

» QuickTime 4.1 is contained on the Canon Digital Camera Solution Disk.

 Plug-In Module is compatible with Adobe Photoshop 3.0 and later versions.

« ArcSoft Photolmpression and ArcSoft Videolmpression require Mac OS 8.5 or higher.
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Installing/Uninstalling the Software
Installing from the Canon Digital Camera Solution Disk

1. Close any programs that are running.
2. Place the Canon Digital Camera Solution Disk in the CD-ROM drive.

3. Double-click the [CD-ROM] icon and the [Canon Digital Camera Installer]
icon.

The installer panel will display.

Canon

@ Software Installation

Canon Utilities

- ImageBrowser

- PhotoStitch

- RemoteCapture

Digital Camera Plug-In Module

® QuickTime Installation

L‘ ® List of Supported Camera Models

® ImageBrowser Software Guide

® Canon Digital Camera Web Site

4. Click [Software Installation].

c
7]
@]
=

=
(&]
]

P

5. Select the programs you wish to install and follow the on-screen
instructions to install them.

6. Click the [Quit] button when the installation is complete and restart the
computer if prompted.
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Installing from the ArcSoft Camera Suite CD-ROM

To install ArcSoft Photolmpression or Videolmpression, place the ArcSoft CD-ROM
into the drive and double-click the [ArcSoft] icon on the desktop followed by the
[English] folder and [Photolmpression Installer] icon or the [Videolmp Installer] icon.
Follow the on-screen instructions to install the program.

Installing from the Adobe Photoshop LE CD-ROM

Place the Adobe Photoshop LE CD-ROM in the drive and double-click the CD-ROM icon,
the [Adobe Photoshop LE] folder and the [Install Photoshop LE] icon. Follow the on-
screen instructions to continue with the installation.

You must input the software serial number to install Adobe Photoshop LE.
It can be found on the CD-ROM case.

Installing from the Adobe PhotoDeluxe CD-ROM

For installation instructions, please see the electronic guide (Getting Started.pdf)
contained in the [Open Me First] folder on the Adobe PhotoDeluxe CD-ROM. Place it in
the drive and click [Readme & Guide] and [Install Guide] in the window that displays.

Write down the serial number shown during installation because it is required
for the user registration process.

Uninstalling the Software

To uninstall a program, drag its folders to the Trash. Be careful, however, not to
accidentally delete any of your images that may be stored in these folders.

For instructions on how to uninstall the Plug-In Module, open the [Canon Utilities] folder
and [Digital Camera Plug-In] folder and read the [ReadMe] file.
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Using ImageBrowser the First Time
(From Loading to Printing)

This section provides a simple explanation of the procedures for using ImageBrowser to
perform each of the steps from loading to printing. Please refer to the ImageBrowser
Help file or PDF file (ImageBrowser Software Guide) for more details. You can access the
ImageBrowser Software Guide from the installer panel.

Some camera models do not support all of the connection interfaces. Please
check the Camera and Software Compatibility chart to confirm your camera’s
compatibility. (O p. 61)

What to Do if a Warning Dialog Displays

« If a set period of time passes without a camera function being accessed when
the camera is connected via the USB interface, a message on the computer
display will ask if you wish to remain connected. If you do not access a
function, the camera will close the connection after an additional minute
passes. (The power will remain on and no message will appear if the camera is
powered by a household power source or its auto power off function is set to Off
(excluding PowerShot S10/S20 models)).

« To reopen the connection, press the camera’s shutter button or main switch. Please
see the Camera User Guide for details.

Starting ImageBrowser
USB Interface

Macintosh

1. Attach the camera to the computer with the USB cable.

Refer to Where to Find Instructions for Attaching Your Camera to a
Computer (O p. ii) for connection instructions.

2. Set the camera to the mode for communicating with a computer.

ImageBrowser will start automatically and display the Communication Settings
dialog.

3. Confirm that [USB Port] and your camera model are selected and click
the [Set] button.
The images from the camera will display as small thumbnail images in the
ImageBrowser Camera Window. (OI' p. 68)
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How to Set ImageBrowser to Not Start Automatically
1. Open the Apple menu & and select [Control Panels] and [Canon USB Cameral].
The *“Settings for USB Connection” dialog will display.
2. Click the [The application program below will start.] option to clear the check mark.
3. Click the close box at the upper left to close the dialog. ImageBrowser will cease to
start automatically thereafter.

|— Click here to close the dialog.

Settings for USB connection ———H

Clear the check mark to stop @m T e
ImageBrowser from S
automatically starting. o o

O Selectwith the Dialog

Startup Program

CF Card Reader or PC Card Slot Interface

1. Place the CF card into the CF card reader or into the PC card adapter
and then into the PC card slot.

Refer to Where to Find Instructions for Attaching Your Camera to a
Computer (O p. ii) for connection instructions.

2. Start ImageBrowser.

Double-click the [Canon ImageBrowser] icon on the desktop to start the
program.
.-'1:_\_\.
Canon ImageBrowser Icon

A

Lanah Snagelrowser

If the [Canon ImageBrowser] icon does not appear on the desktop, open the
[Canon Utilities] folder and [ImageBrowser] folder and double-click the
[ImageBrowser] icon.

3. Double-click the [DCIM] folder in the Explorer View Section.

The images from the CF card will display in ImageBrowser Camera Window as
small thumbnail images. (O p. 68)

== Browser Window

Explorer View Section 7 G0 G
3 3 Macintosh HD

-




167
Serial Interface

1. Attach the camera to the computer with the serial cable.

Refer to Where to Find Instructions for Attaching Your Camera to a
Computer (O p. ii) for connection instructions.

2. Set the camera to the mode for communicating with a computer.

3. Start ImageBrowser.
Double-click the [Canon ImageBrowser] icon on the desktop to start the program.

% ————— Canon ImageBrowser Icon
A

Lanen agebraw'ser

If the [Canon ImageBrowser] icon does not appear on the desktop, open the

[Canon Utilities] folder and [ImageBrowser] folder and double-click the
[ImageBrowser] icon.

4. Click the [Canon Camera] button.

The camera’s images will display as small thumbnail images in the ZoomBrowser
EX Camera Window. (O p. 68)

L
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The ImageBrowser Camera Window

The Camera Window will open when a connection to a camera or CF card is initiated.
Thumbnail (small) images will display.

An image of the connected Thumbnail
camera or CF card will display.

2 Camera Folder

- g o 3B | B R e
Zamw (T SELECT DELETE DOWHLOAD L:E(Igl]r ROTATE UPLOAD SDL'L%E/
Setup Options Button Delete Button Upload Button
Sets various camera Deletes the Copies images from the computer
settings (see inset below) selected to the camera or CF card. (O p. 78)
using the computer. images.

— Download Button

Copies selected images to the computer
from the camera or CF card. (O p. 70)

How to Check and Change Various Camera Settings

 You can adjust the date, time and owner settings in the Camera Settings dialog
using the computer when the camera is connected. You can also check the battery
charge and remaining memory capacity.

1. In ImageBrowser, click the [Setup Options] button to open the Camera Settings
dialog. Or in Plug-In Module, click the [Camera Settings] button to open the
Camera Settings dialog.

2. Check or change the settings.

famera SetngsII—_—_—_——— | Input a camera owner name here. (up
Camera Model: JOOO0O0O0O00X to 31 characters)
e oo 0% |_—— Click this button to synchronize with
[(2000000000000000000000000000000] [ the computer’s date and time settings.
pate aTime [I}//— Set the date and time.
KKK JXIOOOPM |
| ‘ ’l/_,— Check the battery charge here.
Battery Status  AC
——— Formats the CF card in the camera.
c:t - — == (Except in PowerShot $10 / $20 models)
ot ¥ove T———___ Check the remaining memory capacity
here.
Sets the camera parameters (O p. 98)
== (Supported by the EOS D30 only)
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Loading and Saving Images from the Camera

1. Select [Macintosh HD] in the Explorer View Section.

O=—————— Browser Window

ra
“ = Macintosh HD
N

D

Explorer View Section

2. Create a new folder in which to save the images from the camera.

Open the [File] menu and select [New Folder]. A folder with the name ““Untitled”
will be created. Click the folder and change the name as you wish.

Open... #0
< New Folder S >
Send to Tras
Page Setup...
Print... ®P

3. Select the new folder in the Explorer View Section.
3 (] Internet Extras
3 1 Mac 05 RealNde
p [ Uanties

p [ webPages
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Select the images that you wish to download from the Camera Window

and click the [Download] button.

Click the thumbnail you wish to select or press [Shift] and click to select multiple

thumbnails.

Thumbnail —| “RAW”” will display on RAW images.

B

The movie
icon will
display on

BB el

SLIDEF

ROTATE UPLOAD o

4
o

& @ o M=\

SETUP CONNEET gp ey veLere \ novwioan g PRINT
~~—~"

OPTIONS  CAMERA Lavour

movie
thumbnails.

Total Bimages

%

The downloaded images will be saved to the computer disk and
Browser Window.

appear in the

« You can also download images to the computer by dragging them from the
Camera Window and dropping them on the Browser Window or Explorer

View Section.

(] window o8

(& Canon Camera = 1=
¥ & Macintosh HD
b ] Adobe
] Adobe Type utilit]
] Apple Bxtras
[3 ] Applications
] assistants
] canon utilities
] coextras
] Dpesktop Folder
C] nternet
] internetExtras
] Macos Read Me
W Travel
B} utilities
] web Pages

£93-8319_IMG.IPG 883-8320_CRW.CRW

Tyvvvw

B

883-8321_MVIAVI

@ B a A

Kim) D ThasH

REDUCE ENLARGE

Total4images |/

— Explorer View Section

“RAW”” will display
on RAW images.

Browser Window

The movie icon will
display on movie
thumbnails.

To disconnect the camera, click the close box [[] at the upper left of the Camera

Window. The Camera Window wiill close.



Printing Images

1. Select the image(s) you wish to print and click the [Print Layout] button.

< Movie images cannot be printed.
« You must convert RAW images before printing them (pp. 88-89, 99-101).

canon cavens
D

szszsz

nnnnnn
vvvvv

The Print window will display with the images arranged in an auto layout.

2. Adjust the print settings if you wish to change the page layout.

3. Click the [PRINT] button in the Print window.

Print Window

Please see the ImageBrowser Help file for more details on the Print window.

0 =——————"Frint

2]

Landscape in Europe

Change the Image Size
Drag the border to resize
the image.

Add a caption to an image
Click an image and select
[Edit Caption] from the
[Edit] menu.

Click this to reset
the image layout
to the initial
setting.

Click this to rotate
the selected image.

e il T P

Great Not Retired Windmisl

Tulr 1 m

Landscape in Europe

|

— L= e EE

Layout

RE-LAYOUT OPTIONS

FoTaTE  Images PerPage
-

@9

PRINT

7

Edit the Page Title
Open the [Edit]
menu and select
[Edit Header].

Change the Layout
Drag the images to
change the layout.

Add Text

Open the [Edit]
menu and select
[Add Text].

Click this to select
the Layout Type.

(O p. 72)

This button displays
the Print dialog.

This changes the default number
of images printed per page.
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Setting the Image Size for Printing

Fixed Photo Size

Images can be printed at standard photo print size.

Since the images are printed without gaps between them, they look like photo prints
when they are cut with a cutter.

1. Click the [Layout Options] button in the Print window.
The Layout Options dialog will display.

2. Inthe [Layout Type] category, select [Fixed Photo Size].
3. Set the photo size and click [OK].

Printing on Canon Perforated Paper

The [Canon Perforated Paper] option will be selectable in the Layout Options dialog if
you are using a Canon BJ printer that supports Canon Perforated Paper media. Canon
Perforated Paper has perforations at the preset dimensions allowing you to print at the
specified size and simply tear along the perforated lines to produce an image with the
appearance of a finished photo print. Please consult the BJ Solution Disk User’s Guide
for more details.
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Using Additional ImageBrowser Functions

This section explains the additional features of ImageBrowser. Please refer to the
ImageBrowser Help file or PDF file (ImageBrowser Software Guide) for more details.

Some of the software functions are not supported by all of the camera models.
Please check the Camera and Software Compatibility chart to confirm your
camera’s compatibility. (O p. 61)

Displaying Images
Zooming Images In and Out

You can zoom images in and out by clicking the & (REDUCE) or &), (ENLARGE)
button.

Zooming a Single Image

Double-click an image in the Browser Window to display it in the Viewer Window.
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Edit Panel

About the Viewer Window Edit Panel

ji=!] S € CY
ADIUST

CROP COLOR REDUCE ENLARGE

Image Size: 1024768 [Display:  50% Z

Save Button — — Adjust Color Button

Saves the edited Color, brightness and contrast can be
image as a new file. adjusted in the Adjust Color dialog.

—— Crop Button

Drag the mouse cursor to select a crop area and click
this button to trim unwanted portions of images.
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Replaying Movies

Double-click a thumbnail with the movie icon to start QuickTime Player and replay the
movie.

r

BB3-8321_MVILAVI
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Displaying Images in Chronological Order

Select a folder, choose the [Display] menu and select [Switch to TimeTunnel]. All of the
images in the selected folder will display in a time tunnel. To return to the Browser
Window, choose the [Display] menu and select [Switch to Browser View].

o

BrowserWindow

-

13

13

veyvvyy ¥
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& Canon Camera
& Macintosh HD
(1 Adobe
( Adobe Type Utilit]

& Apple Extras
(3 Applications
(1 Assistants

D Extras
(J Desktop Folder
1 internet
(1 internet Extras
(1 Mac 05 Read Me
W Travel
1 utilities
(1 webPages

A D

— Drag the tab up or

down to go backward
or forward in time.
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Showing Images in a Slide Show

The slide show function displays images saved onto the computer disk one-by-one at
full-screen size as if they were part of a slide show.

1. Click the [Display] menu and select [Slide Show Options].

2. Select a play method.

The “Slide Show Options™ dialog will display. Set a play interval and a transition
effect and click the [OK] button.

3. Select images from the ImageBrowser Browser Window for showing.

4. Click the [Display] menu and select [Slide Show].

The selected images will play in order. The slide show will close after the last
image is displayed. If the slide show is set to repeat, press the [Esc] key to close
the slide show.
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Organizing Images
Changing the File Location

You can move an image file or folder by dragging and dropping it in another location.

(a) Drag and drop images from the Browser Window to another
folder in the Explorer View Section.

b Efi_, D Extras |_
b Ei Desktopliolder 856=-5625_AUT.JPG 856=5626_ALT.JPG a5
Explorer View Section b i internet s o
[ Ul _Internet Extras
] Mac0sRead Me
> (3| Powershot Folde
- ., Travel
The file or folder will — |
move to the item - g} e
outlined in blue. i
856-5628_AUT.JIPG
53 Q, @,
lml “ I~ CANON CAMERA, REDUCE ENLARGE

— Browser Window

(b) Drag and Drop a Folder within the Explorer View Section.

ﬁ Applications
[ Assistants
[l _canon Utilities

ﬁ CD Extras

1 Desktop Folder
. Europe

ﬁ Internet

1 internet Extras

1 Mac 05 Read Me
Travi Europe

G utilities
1 web Pages

ﬁ Applications
[ Assistants
[l _canon Utilities

dvvvw vl

-

-

ﬁ CD Extras
1 Desktop Folder
1 internet
ﬁ Internet Extras
1 Mac 05 Read Me
W Travel

ﬁ Europe
G utilities
1 web Pages

Refreshing the Contents of the Browser Window

If you have used the Macintosh Finder or another program to move or edit images
that are registered with ImageBrowser, you should click the [Display] menu and select
[Refresh].
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Erasing Images
Erasing Images Singly
Select the target image in the Browser Window and click the [Send to Trash] button.

Erasing Images by Folder

1. Click the target folder in the Explorer View Section.
The images in the folder will display in the Browser Window.

2. Click the [Send to Trash] button.

0= PBrowserWindow———————[|H

(Z} Canon Camera
¥ = Macintosh HD
b Cj Adobe
[ Adobe Type Utilit
[ Apple Extras
Cj Applications
[} Assistants
[ canon utilities
Cj CDExtras
[} Desktop Folder
[ internet
Cj Internet Extras
[} Mac 05 Read Me
W Travel
Cj Uutilities
[ webPages

883-8319_IMG.JPG 883-8320_CRW.CRW

Y Y Y ww

883-8321_MVIAVI

T~
@ a o«

CANON CAMERA

2

10
i REDUCE ENLARGE
N J Totsl:4 images |7

-
Explorer View Section Send to Trash
Click on a folder in the ~ Button
Explorer View Section to

delete all its images in

one step.
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Browser Window

Click the image in the Browser
Window to delete a single image.

The deleted image files and folders are moved to the Trash folder on the desktop.
To restore the deleted items, open the desktop Trash folder and drag and drop
the target files or folders to their original locations.
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Saving Computer Images to a CF Card in the Camera

1.
2.

Open the Camera Window. (O pp. 68-70)

Click the [Upload] button in the Camera Window.
The “Select Images to Add” dialog will display.

Select the images from the computer and click the [Open] button.
The ““Save to Camera” dialog will display.

Select image size and resizing options and click the [Save to Camera]
button.
The selected image will be saved onto the camera’s CF card.

Adding Sound Annotations to Images

If your computer has a microphone, you can attach a sound annotation to an image by
clicking it in the Browser Window, choosing the [Sound] menu and selecting [Record].

Editing Camera Slide Shows

This function allows you to edit slide shows played by the camera. To edit slide shows
shown on the computer display, see “Showing Images in a Slide Show.” (O p. 75)

1.
2.

Open the Camera Window. (0 pp. 68-70)

Click the [Slide/DPOF] button.
The Edit Slide/DPOF window will display.

Click [Slide Show] in the upper left area of the window.

The camera images will display on the left side. Images registered in the selected
slide show will display on the right side.

Slide Shows 1 to 3 correspond to the numbers of the slide shows that can be shown
with the camera.

Drag and drop images from the area on the left to the area on the right
to register them in the slide show.

You can drag images to change their order in the area on the right. This order
corresponds to the replay order.

Click the [Save to Camera] button.
The slide show wiill be saved to the CF card in the camera.

Click the [Quit] button.
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Editing the Print Order Settings (DPOF)

You can specify which images on a CF card you wish to print as well as the number of
copies. You can also select the print type and whether or not the shooting date and file
number information is printed with the image. A convenient feature of these settings is
that they comply with the DPOF (Digital Print Order Format) standards, which allow you
to print on any DPOF-compliant digital printer or to order prints from a participating
photo developing laboratory.

1. Open the Camera window. (O pp. 68-70)

2. Click the [Slide/DPOF] button.
The Edit Slide/DPOF window will display.

3. Click [Print Order (DPOF)] in the upper left area of the window.

4. Select the print type from among the [Standard Print], [Index Print] or
[Both] options.
« Standard .. Set the number of copies in the No. of Standard Print Copies column
of the images you wish to print.
e Index ....... Click for a check mark below the thumbnails selected for printing.

5. Click the [Save to Camera] button.
The print order settings will be saved to the CF card in the camera.

6. Click the [Quit] button.

DPOF Settings Precaution

« A warning message will display if ImageBrowser encounters print settings data it
does not support on a CF card with print settings created by a non-Canon brand
DPOF-compliant digital camera. If any print settings on such a card are changed, all
of them will be overwritten by ImageBrowser and lost.

« Some printers or photo developing laboratories may not be able to reflect all of the
print settings in the output.

Macintosh
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Adjusting Images for Transmission by E-mail

You can adjust the image size and compression to reduce the file size of an image for
transmission as an e-mail attachment.

1.
2.

Select the target image(s) in the Browser Window.
Click the [File] menu and select [Create Image for Email].

Adjust the image size and compression.

The e-mail image creation window will display.

Set the image size and quality and follow the on-screen messages to complete the
procedures.

Click the [Finish] button.

When you click the [Finish] button, the image will appear in the [Email Images]
folder and your e-mail program will start.

Create a new message.

Drag and drop the image from the [Email Images] folder into the message. Input

your message, a subject, the recipient’s address and send the message.

» Some e-mail programs will not start automatically. Start them manually if required.

» The image file to be sent via e-mail will be saved to the [ImageBrowser.mail]
folder in the [ImageBrowser] folder. If you cannot drag and drop the file from
the [Email Images] folder, look for it in the [ImageBrowser.mail] folder and
attach it to your message.



Merging Panoramic Images with PhotoStitch
To Merge Images Registered in ImageBrowser

< You can merge a series of overlapping images into a single, seamless panorama.

« Select the images in the browser area, choose the [Edit] menu and select
[PhotosStitch]. The PhotoStitch program will start.

< Follow the instructions in the guidance window to merge the images.

« Please refer to the PhotoStitch Help file for more details.

O=———— rprtosStith—=———— OH

@ ; Merge Images Shot in Stitch Assist Mode = . .
\ Click [2. Merge] to merge these images: FO"OW the Instructions
Fe For images shot as a 260-degree panorama, click [Arrange], eelect .
% [360 Degrees] and then click [2. Merge] to merge the |mages

r
4 -

H_01 jpg H_02.jng H_03 jpg

SED

Ho.efImages:d |

Images Shot in Stitch Assist Mode

 PhotosStitch automatically arranges images shot with the Stitch Assist mode of
Canon digital cameras in the correct order and orientation, making it easy to

merge these images. Stitch Assist mode images display in the Camera Window as
shown below.

— Stitch Assist mode images have a green stitch
mark. Click the stitch mark to start PhotoStitch
and merge them.

Please see the Camera User Guide for instructions for shooting in Stitch Assist mode.
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Editing and Applying Special Effects to Images
ArcSoft Photolmpression

1. Confirm that ArcSoft Photolmpression has been installed.
2. Select an image from the Browser Window of ImageBrowser.

3. Click the [Edit] menu and select [ArcSoft Photolmpression].
Please refer to the ArcSoft Photolmpression Help file for instructions for this program.

4. Edit and apply special effects to the image.

ImageBrowser supports the BMP, JPEG, PICT and TIFF file formats.
Click the [Display] menu and select [Refresh] to update the folder data.

Adobe Photoshop LE
1. Confirm that Adobe Photoshop LE has been installed.
2. Select an image from the Browser Window of ImageBrowser.

3. Click the [Edit] menu and select [Adobe Photoshop].

Please refer to the Adobe Photoshop LE Help file and electronic guide (User
Guide.pdf) for instructions for this program.

4. Edit and apply special effects to the image.

« ImageBrowser supports the BMP, JPEG, PICT and TIFF file formats.
« Click the [Display] menu and select [Refresh] to update the folder data.

Adobe PhotoDeluxe
1. Confirm that Adobe PhotoDeluxe has been installed.
2. Select an image from the Browser Window of ImageBrowser.

3. Click the [Edit] menu and select [Adobe PhotoDeluxe].

Please refer to the Adobe PhotoDeluxe Help file and electronic guide
(Getstart.pdf) for instructions for this program.

4. Edit and apply special effects to the image.
< Once you have finished editing the image, click the [File] menu, select [Send to]
and [File Format] and save the image.
« ImageBrowser supports the BMP, JPEG, PICT and TIFF file formats.
« Click the [Display] menu and select [Refresh] to update the folder data.
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Editing Movies
ArcSoft Videolmpression

1. Confirm that ArcSoft Videolmpression has been installed.

2. Double-click the [Videolmpression] icon in the folder in which it was
installed.

ArcSoft Videolmpression will start.

3. Click the [New] button, add a movie or still image to the storyboard (a
board like a film) and perform the edit.
Please refer to the ArcSoft Videolmpression Help file for instructions for this program.
« ImageBrowser supports the MOV and AVI file formats.
« Movie files appear as icons in the ImageBrowser thumbnail view.

c
7]
@]
=

=
(&]
]

P




841

Shooting with RemoteCapture

RemoteCapture will start if you click the ImageBrowser [Edit] menu and select

[RemoteCapture] when the camera is connected to the computer via a USB port.

RemoteCapture lets you activate the camera’s shutter button remotely from the computer.

The captured image is automatically saved into the currently selected ImageBrowser folder.

« RemoteCapture can only shoot still images.

« If an EOS D30 camera is connected via a USB port, clicking the shutter button on the
camera also downloads the image directly to the computer.

RemoteCapture Window

Thumbnail View —— Number of Frames that
Displays thumbnails of all the images shot in the Can Be Captured
current session since RemoteCapture was started. Displays the number of

| images that can be saved

%% RemoteCapture=——————
= | S to the computer or the
S— shots ta 6o camera’s CF card.
@ ¢ P 2954 — . T
"*E Displays the distribution
; | e of brightness data.

Image View \ / Shooting Settings \

Displays the location in

’ which files are saved.
)
Release (D p. 87)
R gwg - Control Buttons
L A e These b_uttons control
e = the basic RemoteCapture
" 205/17 23500 — functions. (O p. 85)
Shooting Mode
S |
mmmmm \ Delete

| Allows you to add
comments to images.

Image View Displays the image information.

Displays the image selected in the Thumbnail View.

How to Start RemoteCapture Instead of Displaying the Camera Window
The settings can be changed so that ImageBrowser automatically starts
RemoteCapture instead of its Camera Window when the camera is connected to
the computer’s USB port.

(1) Click the ImageBrowser [Edit] menu and select [Preferences].
(2) In the Preferences dialog, click the [Camera] tab and set [Camera Controls for
USB Connection] to [Start RemoteCapture].
The RemoteCapture window will now show instead of the ImageBrowser Camera
Window when the camera is connected to the USB port and starts ImageBrowser.



About the RemoteCapture Control Buttons
The control buttons are used to shoot, delete and display images.

Click here to trigger the camera and take a shot. The image is

Release

&x automatically saved to the computer.
Pushing the camera’s shutter button directly will also save the
image to the computer. (Supported by EOS D30 only).

@) Ndegree
. megmj Rotates the image saved to the computer by 90 degrees either way.
Q godegmmJ Select one of these to automatically rotate and save images shot
with the camera swiveled from a horizontal to a vertical orientation.
VE Displays the image selected in the Thumbnail View in the Viewer.
= Deletes the image selected in the Thumbnail View. Please take proper
Delete caution before deleting because deleted images are completely

erased from the computer in one step with this button.

Using Interval and Timer Shooting

RemoteCapture can be used to shoot a set number of images at specified intervals
(Interval Shooting) or to shoot an image after a specified delay (Timer Shooting).

Interval Shooting
You can set the number of frames and the interval at which they are shot.

1.

Click the [File] menu and select [Interval Shooting].
The Interval Shooting dialog will display.

Set the number of frames and interval value and click [Start].
RemoteCapture will start interval shooting, capturing the specified number of
images at the specified intervals.

Timer Shooting
You can set the time delay before an image is shot.

1.

Thumbnails you select in the Thumbnail View can be printed in order on a single index

Click the [File] menu and select [Timer Shooting].
The Timer Shooting dialog will display.

Set the number of seconds and click [Start].

RemoteCapture will start timer shooting, capturing an image after the specified

delay.

Printing a Thumbnail Index Sheet

sheet by clicking the [File] menu and selecting [Print Index]. Since the file name and
shooting date and time can be printed with each image, index sheets serve as a
convenient record of and reference for your images.

185

Macintosh
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Precautions when Shooting with RemoteCapture

« If your computer is set to go into sleep mode, there is no guarantee that
RemoteCapture will continue to function after the computer has entered sleep
mode. Always turn off the sleep function before you start shooting with

RemoteCapture.

« The camera’s auto power save setting is disabled while connected to
RemoteCapture, and the power remains on until manually turned off. You are
recommended to power the camera with a household power source while it is

connected.

 Please note that the camera will not be able to shoot at the specified interval if it is
shorter than the time required to send the image and save it on the computer.

« If the camera is set for “mirror lockup” shooting, the shutter will activate
approximately two seconds after the release button is clicked in RemoteCapture.

(Supported by the EOS D30 only)

Setting Basic Shooting Settings in RemoteCapture

The camera’s shooting settings can be adjusted by clicking the [Shooting Settings] tab

in the RemoteCapture window.

Please adjust the shooting settings for the EOS D30 on the camera itself.

[ Image View \ / shooting Settings \

Test Preview

A preview of the test shot displays.

— Sets the camera’s zoom setting.

Test Shot

Zoom

Test Shot

Size/Quality [ Large/Fine

Flash [ Auto
Macro [ off

White Balance [Autn

o/ lo]lo]lollo]

Exposure [ 0
Compensation

Takes a test shot.
Test shots are not saved to the computer.

— Basic camera settings can be adjusted.
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Changing the Save Location and Other Preferences

The Preferences dialog can be opened by clicking the RemoteCapture [File] menu and
selecting [Preferences]. This dialog can be used to change the save location and
settings.

Preferences=—————

Selects whether the image is saved Fie Setting > I
only on the computer or on the ‘j"c:r'l‘;‘jft'::::w
camera’s CF card too.

(2 CF card first, then computer

File Prefix

Sets the image file prefix. If the prefix Capture (Up to 16 characters)
is set to [Capture], for example, the )
. . . Folder to which Images are Downloaded
first image will be named e T
[Capture_00001.jpg] and successive e ey SelectaFoder:[ | 2]

mages folder.

images will have higher numbers.

Sets the folder in which
the image file is saved.
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Converting RAW Images

The RAW format records the image data as captured by the camera’s image sensor
without further processing by the camera. Although the data is compressed when
recorded, the original data can be completely restored without any loss of quality, making
it possible to obtain high-quality images. Moreover, the RAW image file format is
extremely compact, creating files that are approximately one-third to one-quarter the size
of an uncompressed file (RGB TIFF). Please refer to your Camera User Guide to learn how
to set the camera to shoot in the RAW format.

The process of obtaining high-quality RGB signals from RAW format images (hereafter
RAW images) is called “conversion.” Since ImageBrowser can be used to adjust the
attributes of the original data, you can achieve the effects you wish while maintaining
high image quality. In contrast, image data recorded in the RGB TIFF and other standard
uncompressed file formats is irrevocably processed in the camera and must be further
processed irrevocably by retouching software to change the attributes, which reduces the
image quality.

Please note that ImageBrowser or the Plug-In Module are required to load RAW images
onto a computer.

Converting RAW Images without Adjusting the Quality

1. Select a RAW image.
Select a RAW image from the Browser Window of ImageBrowser.

2. Click the [File] menu and select [Convert RAW Images].

The image is converted and saved in a new TIFF (8 bits/channel) file. To learn how
to change the file format, please see “How to Change the File Format™ (O p. 89).

Converting RAW Images with Quality Adjustment

1. Select a RAW image from the Browser Window of ImageBrowser.

2. Click the [File] menu and select [Convert RAW Images with User
Defined Parameters].
The RAW Image Parameter Settings dialog will display.

3. Select the quality settings and click [OK].
The RAW image is converted according to the specified parameters and saved in
a new TIFF (8 bits / channel) file. If multiple RAW images are selected, the
parameters are applied only to the first image. When only one RAW image is
adjusted, the changes are also reflected in the remaining images in the selection.
To learn how to change the file format, please see “How to Change the File
Format™” (O p. 89).



RAW Image Parameter Settings Dialog

Click this and a white point of the
image in the Preview Area to set it
as the value for the white balance.

189

Preview Area

aw Image Parameter Settings ——|

The RAW Image Tuning dialog is used to set the conversion param(>ters for the RAW
image data.

White Balance

As Shot (Auto) :

Parameter setting selections are
reflected in the preview image.

Contrast

As Shot (Normal) :

Sharpness

As Shot (Normal) :
Color Saturation

As Shot (Normal) :

Linear

Placing a check here applies linear processing to the contrast, sharpness and color saturation,
and allows the images to be edited with photo retouching software, such as Adobe

Photoshop.

« The [Linear] option is only enabled when [TIFF 16 bits/channel] is selected as the file format.

Selecting and Adjusting the Attributes of Multiple RAW Images

Ensure that all images included in a multiple selection of RAW images are from the
same camera before attempting to adjust the image attributes. The white balance
will not adjust properly if images from different cameras are mixed and the [Manual]

’7—‘[‘ Full-Size Preview

]

[Shooting Settings] [ Cancel 11 0K ]|
|

Displays the image in the
Preview Area at full size.

I
Resets the image quality
settings to the state in which
the image was shot.

white balance option is selected in the RAW Image Parameter Settings dialog or if a
white portion of the image is selected in the preview area.

How to Change the File Format

1. Click the ImageBrowser [Edit] menu and select [Preferences].
The Preferences dialog will display.
2. Change the format selected in the [File Format] tab and click [OK].

Saving in the TIFF 16 Bits / Channel Format
When [TIFF 16 bits/channel] (supported by the EOS D30 only) is selected as the file
format for saving RAW images, 16 bits of data is used to record each RGB channel.
This image format can be used in several application programs, such as Adobe
Photoshop LE. Formats other than TIFF 16 bits/channel all save the image using 8 bits

per RGB channel.
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Loading Images with Plug-In Compliant
Application Programs

This section explains how to load images with Plug-In compliant application programs
using Adobe Photoshop LE or Adobe PhotoDeluxe. Please refer to the manual for each
application program for more details.

Since ArcSoft Photolmpression and ArcSoft Videolmpression are not Plug-In compliant
programs, images cannot be downloaded via the Plug-in Module.

Using Adobe Photoshop LE
Installing the Software
Installing Plug-In Module

This program is required to load camera images into Plug-In compliant application
programs. For instructions, see “Installing / Uninstalling the Software” (O p. 63).

Installing Adobe Photoshop LE

Place the Adobe Photoshop LE CD-ROM in the drive and double-click the CD-ROM
icon, the [Adobe Photoshop LE] folder and the [Install Photoshop LE] icon. Follow the
on-screen instructions to continue with the installation.

You must input the software serial number to install Adobe Photoshop LE.
It can be found on the CD-ROM case.

Copying Plug-In Module to the [Plug-Ins] Folder
1. Open the [Canon Utilities] and [Digital Camera Plug-In] folders.

2. Copy the [Canon Digital Camera Plug-In] file to the Adobe Photoshop LE
[Import / Export] folder.

Open the [Adobe Photoshop LE], [Plug-Ins] and [Import / Export] folders and copy
the [Canon Digital Camera] file into the [Import / Export] folder.

Starting Adobe Photoshop LE
Connecting the Camera to a USB Port

1. Connect the camera to the computer’s USB port.

Refer to Where to Find Instructions for Attaching Your Camera to a
Computer (O p. ii) for connection instructions.

2. Set the camera to the mode for communicating with a computer.

Although ImageBrowser will automatically start after a moment, you need to
close it at this point.
 See page 66 to learn how to set ImageBrowser so that it does not start automatically.

3. Start Adobe Photoshop LE.
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What to Do if the “ImageBrowser not found” Dialog Appears

If you install only the Canon Digital Camera Plug-In Module without ImageBrowser,
the “ImageBrowser not found” dialog may display. If this happens, use the following
procedures to prevent ImageBrowser from attempting to start automatically.

1. Click the [OK] button on the “ImageBrowser not found” dialog.
2. In the “Settings for USB connection” dialog, click the [The application program
below will start.] option to clear the check mark.
3. Close the “Settings for USB
connection" d|a|og ImageBrowser not found.
This will prevent the
“ImageBrowser not found” dialog

i

from appearing again when the “{ “EE
camera is connected. \Lzm — )¢
. The “Sett|ngs fOf USB C“Ck here P@rnz::nm;;;et:tinn options

connection” dialog can be to close the O Select with the Diotag

opened by choosing the Apple  dialog. startus roaram

menu i and selecting

[Control Panels] and [Canon Click here to

USB Camera]. (O p. 66) clear the

check mark.

Connecting via a CF Card Reader or PC Card Slot

1. Place the CF card into the CF card reader or into the PC card adapter
and then into the PC card slot.

Macintosh

Refer to Where to Find Instructions for Attaching Your Camera to a
Computer (O p. ii) for connection instructions.

2. Start Adobe Photoshop LE.
Serial Interface

About AppleTalk

When connected to the printer or modem port via AppleTalk, choose the Apple
menu g, select [Chooser] and set AppleTalk to [Inactive].

1. Connect the camera to the computer with the serial cable.

Refer to Where to Find Instructions for Attaching Your Camera to a
Computer (O p. ii) for connection instructions.

2. Set the camera to the mode for communicating with a computer.

3. Start Adobe Photoshop LE.
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Starting Plug-In Module and Loading Images

Plug-In Module can display still images only. Please start ImageBrowser to download
movies to the computer.

1.

Downloading Images from the Camera

Click the Adobe Photoshop LE [File] menu and select [Import] and
[Canon Digital Camera Plug-In].
Plug-In Module will Start.

Click the icon and set the communication settings.

* USB Interface...... Confirm that [USB Port] and your camera model have been
selected and click the [Set] button.

« Serial Interface ... Select the port and baud rate settings and click the [Set]
button (O p. 102).

Click the [Camera] button.
The images from the camera will display in the Thumbnail Display Area.

Select the images you wish to download and click the [Acquire] button.
The images will appear in the Adobe Photoshop LE window.

Click the [Quit] button to close Plug-In Module.
To save the loaded images, click the Adobe Photoshop [File] menu and select [Save].
Input a file name and change the file location and format settings if necessary.

Downloading Images Directly from a CF Card

Click the Adobe Photoshop LE [File] menu and select [Import] and
[Canon Digital Camera Plug-In].
Plug-In Module will start.

Click the [Computer] button.

Select the folder containing the images and click [Select].
The images on the CF card will appear in the Thumbnail Display Area.

Select the images you wish to download and click the [Acquire] button.
The images will appear in the Adobe Photoshop LE window.

Click the [Quit] button to close Plug-In Module.

To save the loaded images, click the Adobe Photoshop LE [File] menu and select
[Save As]. Input a file name and change the file location and format settings if
necessary.
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Guide to the Plug-In Module Window

Preferences Button Display Style Button
Displays and changes the Changes the shape of the
image transmission thumbnail display area.

settings. (O p. 101)

Rotate 90 Degrees Buttons

Camera Settings Button —— Rotates selected image left or right
Use to display and change 90 degrees.

the camera settings.

(O p.68) — Image Information Button

Displays image details
Communication

Settings Button —— RAW Button
Sets the settings Adjusts the quality at
for communicating which RAW images

with the camera. are converted.

(@ p. 99)
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Main Buttons . L— Thumbnail Display Area

Use them to perform the main Thumbnails of the camera’s
commands such as acquiring images and images display here when it is
closing the program. connected.
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Using Adobe PhotoDeluxe
Installing the Software
Installing Plug-In Module

This program is required to load camera images into Plug-In compliant application
programs. For instructions, see “Installing/Uninstalling the Software” (O p. 63).

Installing Adobe PhotoDeluxe

For installation instructions, please see the electronic guide (Getting Started.pdf)
contained in the [Open Me First!] folder on the Adobe PhotoDeluxe CD-ROM.

The serial number shown during installation will be required for the user
registration process.

Copying Plug-In Module to the [Plug-Ins] Folder

1. Open the [Canon Utilities] and [Digital Camera Plug-In] folders.

2. Copy the [Canon Digital Camera Plug-In] file to the Adobe
PhotoDeluxe [Import / Export] folder.

Starting Adobe PhotoDeluxe
Connecting the Camera to a USB Port

1. Connect the camera to the computer’s USB port.

Refer to Where to Find Instructions for Attaching Your Camera to a
Computer (O p. ii) for connection instructions.

2. Set the camera to the mode for communicating with a computer.
Although ImageBrowser will automatically start after a moment, you need to
close it at this point.

» See page 66 to learn how to set ImageBrowser so that it does not start
automatically.

3. Start Adobe PhotoDeluxe.
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What to Do if the “ImageBrowser not found” Dialog Appears

If you install only the Canon Digital Camera Plug-In Module without ImageBrowser,
the “ImageBrowser not found” dialog may display. If this happens, use the following
procedures to prevent ImageBrowser from attempting to start automatically.

1. Click the [OK] button on the “ImageBrowser not found” dialog.
2. In the “Settings for USB connection” dialog, click the [The application program
below will start.] option to clear the check mark.
3. Close the “Settings for USB
connection" d|a|og ImageBrowser not found.
This will prevent the
“ImageBrowser not found” dialog

i

from appearing again when the “{ “EE
camera is connected. \Lzm — )¢
. The “Sett|ngs fOf USB C“Ck here P@rnz::nm;;;et:tinn options

connection” dialog can be to close the O Select with the Diotag

opened by choosing the Apple  dialog. startus roaram

menu i and selecting

[Control Panels] and [Canon Click here to

USB Camera]. (O p. 66) clear the

check mark.

Connecting via a CF Card Reader or PC Card Slot

1. Place the CF card into the CF card reader or into the PC card adapter
and then into the PC card slot.

Macintosh

Refer to Where to Find Instructions for Attaching Your Camera to a
Computer (O p. ii) for connection instructions.

2. Start Adobe PhotoDeluxe.
Serial Interface

About AppleTalk

When connected to the printer or modem port via AppleTalk, choose the Apple
menu g, select [Chooser] and set AppleTalk to [Inactive].

1. Connect the camera to the computer with the serial cable.

Refer to Where to Find Instructions for Attaching Your Camera to a
Computer (O p. ii) for connection instructions.

2. Set the camera to the mode for communicating with a computer.

3. Start Adobe PhotoDeluxe.
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Starting Plug-In Module and Loading Images

Plug-In Module can display still images only. Please start ImageBrowser to download
movies to the computer.

1.
2.
3.

1.

Click the [Get Photo] button in the upper left area of the window.
Click [Get Photo] from the tab that displays and select [Cameras].

In the Select Input Source dialog, select [Canon Digital Camera Plug-In]
and click the [OK] button.
This step is not required after the first time.

Click the [Camera] icon.
The Plug-In Module will start.

Downloading Images from the Camera

Click the |Ei| icon and set the communication settings.

This step is only required for connections via the USB or serial ports.

* USB Interface...... Confirm that [USB Port] and your camera model have been
selected and click the [Set] button.

« Serial Interface ... Select the port and baud rate settings and click the [Set]
button (O p. 102).

Click the [Camera] button.
The images from the camera will display in the Thumbnail Display Area.

Select the images you wish to download and click the [Acquire] button.

Input the file name in “untitled” box and click the [Save] button.
The thumbnail will appear in the [My Photo] window at the lower right of the
Adobe PhotoDeluxe window.

Click the [Quit] button to close Plug-In Module.

To save the loaded images, click the Adobe PhotoDeluxe [File] menu and select
[Save As]. Input a file name and change the file location and format settings if
necessary.

Downloading Images Directly from a CF Card

Click the [Computer] button.
The dialog will display.

Select the folder containing the images and click [Select].
The images on the CF card will appear in the Thumbnail Display Area.

Download images using steps 3 to 5 of “Downloading images from
the Camera”.
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Guide to the Plug-In Module Window

Preferences Button Display Style Button
Displays and changes Changes the shape of the
the image transmission thumbnail display area.

settings. (O p. 101)

Rotate 90 Degrees Buttons

Camera Settings Button —— Rotates selected image left or right
Use to display and change 90 degrees.

the camera settings.

(O p.68) — Image Information Button

Displays image details
Communication

Settings Button —— RAW Button
Sets the settings Adjusts the quality at
for communicating which RAW images
with the camera. are converted.

(@ p.99)
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Main Buttons . L— Thumbnail Display Area

Use them to perform the main Thumbnails of the camera’s
commands such as acquiring images and images display here when it is
closing the program. connected.
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Setting the Parameters (EOS D30 Only)

Up to three sets of parameters for loading images can be set in the Plug-In Module using
the Parameter Settings dialog in addition to the parameters already set on the camera.

Please see the Camera User’s Guide to learn how to select the parameters for the camera
that are set with the computer.

1. Click the [Camera Settings] button in the Plug-In Module window.
The Camera Settings dialog will display.

2. Click the [Parameters] button.
The Parameter Settings dialog will display.

3. Click [Add Set].
Click [Add Set] and select the number of the set you wish to add.

4. Set each parameter.

5. Click [Apply to Camera].
The settings will be applied to the camera.

Parameter Settings Dialog

Paramer Settings

This dialog can be used to set the conversion parameters for the camera's
creative zone. Parameter sets labeled Setl-5e13 can be applied 1o the camera.

/ m Setl |, m Set2

|'— Contrast

Sets the various parameters. [ Sharpness ‘ .

Color Saturation

Loads the contents of a
parameter set saved to the f Loadseuings | [ save sertings | | [ Apply 10 camera -

computer’s hard disk.
[ Add ser | [_petete ser |
Click here first to add a new
parameter set to the camera.
Saves the parameter set to Applies the current
the computer. parameter set to the
To load the saved parameter camera.

set, click [Load Settings].



Converting RAW Images

The RAW format records the image data as captured by the camera’s image sensor
without further processing by the camera. Although the data is compressed when
recorded, the original data can be completely restored without any loss of quality, making
it possible to obtain high-quality images. Moreover, the RAW image file format is
extremely compact, creating files that are approximately one-third to one-quarter the size
of an uncompressed file (RGB TIFF). Please refer to your Camera User Guide to learn how
to set the camera to shoot in the RAW format.

The process of obtaining high-quality RGB signals from RAW format images (hereafter RAW
images) is called “conversion.”” Since the Plug-In Module can be used to adjust the attributes
of the original data, you can achieve the effects you wish while maintaining high image
quality. In contrast, image data recorded in the RGB TIFF and other standard uncompressed
file formats is irrevocably processed in the camera and must be further processed irrevocably
by retouching software to change the attributes, which reduces the image quality.

Please note that ImageBrowser or the Plug-In Module are required to load RAW images

onto a computer.

« ArcSoft Photolmpression is not a Plug-In compliant program, and this function can not
be used.

Converting RAW Images without Adjusting the Quality

1. Select a RAW image.
Select a RAW image from the Thumbnail Display Area of the Plug-In Module.

2. Click the [Acquire] button.
The image will be converted and sent to Adobe Photoshop or Adobe
PhotoDeluxe at 8 bits per RGB.
To learn how to change the file transmission format, please see “How to Change
the File Transmission Format” (O p. 101).

199

Macintosh
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Converting RAW Images with Quality Adjustment

1. Select a RAW image.
Select a RAW image from the Thumbnail Display Area of the Plug-In Module.

2. Click the Plug-In Module [RAW] button.
The RAW Image Parameter Settings dialog will display.

3. Select the quality settings and click [OK].
When an image is adjusted, the “RAW” symbol shown on its thumbnail will
change from white to green. If multiple RAW images are selected, the parameters
are applied only to the first image. When only one RAW image is adjusted, the
changes are also reflected in the remaining images in the selection.

4. Click the [Acquire] button.

The RAW image will be converted according to the specified parameters and the data

will be sent to Adobe Photoshop LE or Adobe PhotoDeluxe at 8 bits per RGB channel.

To learn how to change the file transmission format, please see “How to Change

the File Transmission Format™ on the next page.

« The image quality settings return to the default settings when the Plug-in
Module is closed. The settings will also be reset to the defaults if the
connection to the camera is broken, or if the Plug-In Module window is
refreshed as a result of an image being shot or deleted with the camera while it
is connected.
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RAW Image Parameter Settings Dialog

Preview Area

Click this and a white point of the
image in the Preview Area to set it aw Image Parameter Settings ———
as the Value for the Wh|te balance. ’m’;;:.aqe Tuning dialog is used to set the conversion paramleters for the RAW.
White Balance
Parameter setting selections are Asshattwty 7] [#]
reflected in the preview image. TSI

Sharpness
As Shot (Normal) :

Color Saturation

As Shot (Normal) :

Linear

[Shooting Settings] [ Cancel 11 0K ]|
|

I
Displays the image in the Resets the image quality settings to the
Preview Area at full size. state in which the image was shot.

’7 Full-Size Preview

Placing a check here applies linear processing to the contrast, sharpness and color saturation,
and allows the images to be edited with photo retouching software, such as Adobe
Photoshop.

« The [Linear] option is only enabled when [TIFF 16 bits/channel] is selected as the file format.

Selecting and Adjusting the Attributes of Multiple RAW Images

Ensure that all images included in a multiple selection of RAW images are from the
same camera before attempting to adjust the image attributes. The white balance
will not adjust properly if images from different cameras are mixed and the [Manual]
white balance option is selected in the RAW Image Parameter Settings dialog or if a
white portion of the image is selected in the preview area.

c
7]
(@]
=

=
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How to Change the File Transmission Format

1. Click the [Preferences] button in the Plug-In Module window.
The Preferences dialog will display.

2. Change the transmission format in the [Send RAW image data to the
application as] option and click [OK].

Transmitting in the TIFF 16 Bits / Channel Format

When [16 bits per color channel] (supported by the EOS D30 only) is selected as the
transmission option for RAW images, images can be transmitted to the application at 16
bits per RGB channel. Although colors are expressed more vividly with the 16-bit setting
than the 8-bit setting, the file size increases dramatically. Moreover, some image editing
applications function only partially with files of this format or cannot open them at all.
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Troubleshooting the Computer Connection

Double-Check:
1. Is the cable between the camera and computer correctly attached?
Refer to Where to Find Instructions for Attaching Your Camera to a
Computer (O p. ii) for connection instructions.

2. Is the camera’s power on?

3. Is the battery charge sufficient?
We suggest that you use the AC adapter to power a camera connected to a computer.

If the above conditions are met, check the following items.

« Have you tried switching the cable to a different port?
If there is more than one port, try switching the cable to another port.

« Are the communication settings appropriate?
If the settings for the port to which the camera is connected are incorrect, the
Communication Settings dialog will display.

Windows Platform

Communication Settings

Port Type

2]

E—"] |

LCommunication Port:

Baud Riate:

|
Detect 1

[

o ]

Cancel |

Macintosh Platform

Communication Settings

Baud Rate:

Modem Port Sl
115.2Kbps B————

Cancel

Set

—— Select [USB] or [RS-232C].

—— Select the port to which the interface cable is

connected.

If you are unsure to which serial port you are
connected, click the [Detect] button.

Normally you should not need to change this
setting, but set it to a lower speed if you try
everything else and still cannot load images.

Select the port to which the interface cable is
connected.

Normally you should not need to change this
setting, but set it to a lower speed if you try
everything else and still cannot load images.

If these remedies do not work, please contact the nearest Canon Customer Support

Help Desk.
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Customer Support

Canon Customer Support

Canon Inc.
30-2 Shimomaruko 3-chome, Ohta-ku, Tokyo
146-8501, Japan

NORTH AMERICA
Canon U.S.A., Inc.

Canon Customer Care Center

Phone (US): 1-800-828-4040

(Available Mon. - Fri., 9 AM to 8 PM Eastern Time)
Canon Canada Inc.

Phone (Canada): 1-800-OK-CANON (1-800-652-2666)
(24 hours/day, 7 days/week)

EUROPE

Europe, Africa & Middle East
Canon Europa N.V.
PO Box 2262, 1180 EG Amstelveen, The Netherlands

Canon (UK) Ltd.

Helpdesk

Tel No.: 08705 143 723 (Calls may be recorded.)
Fax No.: 08705 143 340

Canon France S.A.

Hotline : 01.41.99.70.70

Tél: 01.41.99.77.77 Télécopie : 01.41.99.79.51
Canon Photo Vidéo France S.A.

Support Client: 01.41.30.15.15

Fax: 01.41.30.15.05

Canon Deutschland GmbH

Canon Hotline Service:

Customer Support: (02151) 349-555

Info Desk: (02151) 349-566

Fax: (02151) 349-588

Canon Euro-Photo GmbH
Customer-Support: (02154) 495-482 or 483

Fax: (02154) 495-489

Canon Italia S.p.A.

Pronto Canon : 02 8249 2000

Canon Belgium N.V. / S.A.

Helpdesk: 0900-10627

Tel.: (02) 722.04.11  Fax: (02) 721.32.74
Canon Luxembourg S.A.

Tel.: (352) 4847 961  Fax: (352) 48 47 96232

Canon Nederland N.V.

Helpdesk: 023 - 5 681 681

Tel.: 023-5670123 Fax: 023 -5 670 124
Canon Danmark A/S

Phone: +45 44882400

e-mail: helpdesk@canon.dk

Canon Espafia S.A.

Help Desk: 906 301 255

Fax: (91) 411 76 65

E-mail: helpdesk1@btlink.net

Canon Norge as
TIf. 22629321 Faks: 22 62 06 15
E-mail: helpdesk@canon.no
Finland
Canon OY
Puhelin: 010 54420  Fax: 010 544 4571
Help Desk: 0600 0 22606 (14,80 mk/min+pvm)
Help Desk: 0600 0 22666 (enint. 40mk/puhelu+pvm)
Séhkoposti: helpdesk@canon.fi
Canon (Schweiz) AG
Tel. 01-835-6161, Fax 01-835-6526
Hotline 0900 57 55 20
Canon Svenska AB
Tel: 08-744 85 00 Fax: 08-744 64 65
Austria
Canon GmbH
Oberlaaerstrafle 233 A-1100 Vienna
Tel: 01 680 88-0  Fax: 01 680 88-308

OCEANIA

Canon Australia Pty. Ltd.
Info-Line: (02) 9805 2864

Canon New Zealand Ltd.
Info-Line: 0900-522666

ASIA

Canon Singapore Pte. Ltd.
79 Anson Road, #09-01 / 06, Singapore 079906
Phone: (65) 532 4400  Fax: (65) 221 7577

Canon Hongkong Co., Ltd.

9/F, The Hong Kong Club Building, 3A Chater Road,
Central, Hong Kong

Phone: 852-2739-0802  Fax: 852-2369-7701

Canon Marketing Services

No.1 Jalan Kilang Timor, #09-00, Pacific Tech Centre,
Singapore 159303

Phone: (65) 799 8888  Fax: (65) 273 3317

Canon Marketing (Malaysia) Sdn. Bhd.
Wisma General Lumber, Block D, Peremba Square,
Saujana Resort, Section U2, 40150,

Shah Alam, Selangor Darul Ehsan, Malaysia
Phone: (60) 3 744 6000, (60) 3 745 0055

Fax: (60) 3 745 0505

Canon Marketing (Thailand) Co., Ltd.
10th Floor, Bangkok City Tower,

179/34-45 South Sathorn Road,

Bangkok 10120, Thailand

Phone: (662) 344 9999  Fax: (662) 344 9910

Canon Marketing (Hongkong) Co., Ltd.
10/F, Mirror Tower, 61 Mody Road, Tsimshatsui East

Kowloon HongKong
Phone: 852-2170-2828

Macintosh

Fax: 852-2723-9684
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Adobe Customer Support

Adobe Systems Inc. technical support information is available in the PDF file format on the
supplied CD-ROM.

PDF File Location and Opening Instructions

Place the Adobe Photoshop LE CD-ROM in the drive and double-click the [My Computer]
icon on the Windows desktop, followed by the [Photosle] CD-ROM icon. The window will
show folders with language names. Double-click the appropriate language folder and the
[Support.pdf] file within it.

» To read PDF files, Adobe Acrobat Reader must already be installed on your computer. An
installer for this program is on the Adobe Photoshop LE CD-ROM within each language
folder in a folder labeled [Acroread].

ArcSoft Customer Support

North America

46601 Fremont Blvd., Fremont, CA 94538
Tel: (510) 440-9901 (Mon. - Fri., 8:30 AM - 5:30 PM PST)
E-mail: support@arcsoft.com

Other Regions
Please see the ArcSoft web site: http://www.arcsoft.com/maininternational.html.



